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Collaboration
Is No Longer Optional
Although we cling to the romantic image of the lone scientific investigator
uncovering some fundamental truth, the current model of scientific investigation
is better represented by the Large Hadrain Collider (LHC). The world’s largest and
highest-energy particle accelerator, LHC will be used by more than 10,000 researchers
in 85 countries to test predictions about the nature of high-energy physics when it
goes back online. Michael Goodchild, in his address at the Space-Time Modeling
and Analysis Workshop held in Redlands, California, in February 2010, reminded
attendees of this reality and asserted the important work in science is being
conducted by teams that are making discoveries about complex systems. Scientific
teams making these discoveries require “powerful data acquisition systems and
sophisticated tools, and when these systems are embedded in geographic space-time;
they need GIS.”
GIS has been instrumental in giving us a greater appreciation of the complexity
and interdependency of many systems—ecological, geologic, and social—and the
challenges facing those systems. It has been tremendously useful in managing and
analyzing the myriad of measurements we’ve been collecting relating nearly every
aspect of the planet.
The vision of a societal GIS has been around for more than a decade. However,
recent developments have made that vision much closer to reality. Now Web,
mobile, and the Cloud are viable platforms for accomplishing GIS work. But it is
the advent of GeoDesign in combination with these platforms and the new GIS
tools being developed that are making GIS a more powerful collaboration tool for
GIS professionals and more accessible to nearly everyone. As Jack Dangermond
has observed, GIS isn’t touching just a few researchers, GIS professionals, or those
who work with geographic information, “but it’s infecting and affecting virtually
everything that people do.”
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ArcGIS
10
Will Transf
A simple and pervasive system
The new editing
environment in
ArcGIS 10 lets
users accomplish
editing tasks in
a more intuitive,
task-based
manner.

ArcGIS 10 implements a vision of GIS as a
simple and pervasive system for using maps
and geographic information.
This release was called ArcGIS 9.4 in the
beta phase. However, feedback from more than
2,000 beta participants indicated this update—
featuring hundreds of improvements—should
be called ArcGIS 10.
ArcGIS 10 will make GIS easier, more accessible, and more collaborative. It employs
a much simpler user interface—a map. This
map-centric approach is used for interacting,
querying, editing, sharing, analyzing, and combining data.
The focus in ArcGIS 10 is squarely on helping users get more done. ArcGIS 10 integrates
productivity tools that support the workflows
of GIS professionals. Best practices templates
incorporate intelligence that helps users get
started quickly without having to worry about
configuring the geodatabase.
A new, enhanced editing experience lets
6 ArcUser Spring 2010

users accomplish editing tasks in a more intuitive, task-based environment. Users spend less
time searching for tools and less time learning
how to use them.
Commonly used tools for editing have been
moved to a new toolbar that follows the user
from task to task so it is always handy. The new
toolbar for snapping is map based, and a new,
quick pop-up helps users choose the desired
feature.
Some enhancements were developed specifically for parcel editing tasks. The Create
Features panel gives a more graphic, sketchbased way of creating features. The ability to
perform bulk map feature editing and automated changes in parcel ownership that retain
parcel accuracy helps users spend less time accomplishing more.
At ArcGIS 10, users can search by keywords
or data types to find data and maps. They can
also use the search function to quickly and easily find symbols to use in their maps and tools

for analysis.
Users can work faster because ArcGIS 10
is faster. The higher performance of ArcGIS 10
results from averaging local graphics cards on
desktops and improving cache generation and
management, as well as optimizing Web graphics. These caching and Web graphic improvements translate into more responsive drawing
performance that includes smooth, continuous
panning of data.
This upcoming release also introduces the
notion of time in both visualization and analysis. The software is time aware at the data,
interface, and tool level. ArcGIS 10 lets users
create, manage, and visualize time-aware data.
They can display and animate temporal datasets as well as publish and query temporal map
services. The ability to see data over time opens
opportunities for more in-depth analysis.
ArcGIS has always been the premier software for spatial analysis. With this release,
ESRI advances geographic science with new
www.esri.com
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orm How People Use GIS
tools. Using Python, the capabilities of ArcGIS
can be combined with other scientific programming to create powerful solutions and automate
common tasks.
Analysis and visualization in 3D is also improved in ArcGIS 10. At this release, ArcGIS
becomes a full 3D GIS, offering 3D data models, editing, analysis, and visualization. It is
much easier and faster to perform 3D visualization and users can do virtually everything
that they do in a 2D environment in a 3D
environment.
ArcGIS is expanding GIS to be more fully
realized on mobile devices. Now users will
be able to experience all the aspects of GIS
on the mobile platform in the field and, often,
in real time. This release makes GIS easier to
use on Tablet PCs. Not only can users create
custom applications but ArcGIS Mobile also
has a customizable, out-of-the-box application that allows users to extend ArcGIS. ESRI
is expanding this concept not only to Windows
Mobile but also to the iPhone platform. ESRI
is providing a software developer kit (SDK)
so organizations can build their own focused
iPhone applications. The mobile platform enables the use of GIS information throughout
organizations.
The expansion of GIS use is improved with
added support for cloud computing. ArcGIS
at 9.3 is cloud ready. ArcGIS 10 will be even
more tightly integrated with the ArcGIS Online
search and share capabilities. This makes it
easier for users to create and distribute projects that may include data, layers, maps, tools,
scenes, globes, diagrams, and add-ins.
Also at version 10, ArcGIS will be extended
to support enterprise clouds. Any client can access these server-based resources and integrate
data through mashups and APIs. In addition,
ESRI is collaborating with Amazon Web Services (AWS) and has joined the growing community of AWS Independent Software Vendors
(ISVs) building services and solutions in the
cloud computing environment.
Another area where ESRI has focused a
great deal of energy over the last two years
has been integrating imagery into the ArcGIS
platform. With this release, ArcGIS is a strong
platform for imagery. It dramatically improves
display speed and builds on the notion of onthe-fly image analysis, now done on ArcGIS
Server, but soon available on the desktop. The
image processing tools on the desktop furnish
www.esri.com

Commonly used tools for editing have been moved to a new toolbar that follows the user from
task to task. The new toolbar for snapping helps users quickly adjust tolerances for snapping.

ArcGIS 10 is a full 3D GIS with 3D data models, editing, analysis, and visualization.
display speed that is extraordinary.
ArcGIS 10 is expected to ship during the
second quarter of 2010. Find the latest infor-

mation on ArcGIS 10, including podcasts and
videos, at www.esri.com/whatscoming.
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New

fuzzy logic tools
in

ArcGIS 10
By Gary L. Raines, Don L. Sawatzky, and Graeme F. Bonham-Carter

For many spatial modeling problems, experts can describe the
decision-making process used to predict real-world phenomena: the
favorability for locating mineral deposits or archaeological sites, the
occurrence of hazards such as landslides or disease outbreaks, the
habitat of specific animals or plants, or the optimal site for a business. For most interesting spatial problems, expert knowledge is often
expressed in terms such as nearness to some feature or by statements
involving sometimes or maybe. Such semantic descriptions are useful
but imprecise.
Fuzzy logic is used extensively in poorly definable engineering
applications such as the anti-lock braking system (ABS) that controls
brakes in cars; the focusing and exposure controls on digital cameras;
and the control of water intake, temperature, and other settings in
high-end washing machines. Fuzzy logic provides an approach that
allows expert semantic descriptions to be converted into a numerical
spatial model to predict the location of something of interest.

8 ArcUser Spring 2010

In addition to Boolean logic and Weighted Overlay tools in
ArcGIS 10, two new Overlay tools—Fuzzy Membership and Fuzzy
Overlay—are available. Overlays using fuzzy logic provide more
flexible weighting of evidence and combinations of evidence than
traditional Boolean or Weighted Overlays. These new tools in ArcGIS
are derived from the Spatial Data Modeller (SDM) toolbox developed
by the U.S. Geological Survey and the Geological Survey of Canada.
[SDM is a collection of geoprocessing tools for spatial data modeling
that is available from ArcScripts at http://arcscripts.esri.com/details.
asp?dbid=15341.] The Fuzzy Logic tool is just one of many methods
available from the SDM toolbox that includes weights of evidence,
logistic regression, expert systems, and model validation.
A Nonspatial Example
Table 1 illustrates a simple example of a nonspatial Boolean and fuzzy
logic model through a chart on tallness. Boolean logic deals with

www.esri.com
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Table 1: A nonspatial example comparing
Boolean logic with fuzzy logic. In Boolean
logic, truth is “crisp,” zero or one. In fuzzy
logic, truth has degrees between zero and
one. Fuzzy tallness and fuzzy oldness are
the membership in the concepts tallness
and oldness. Boolean tallness and Boolean
oldness are binary memberships in these
concepts. Thus in Boolean logic, a person is
either tall or not; whereas in fuzzy logic, a
person can be somewhat tall. The operators
AND and OR are used for combining
evidence in both methods.

Evidence
Person

Height

Fuzzy
Tallness

Boolean
Tallness

Age

Fuzzy
Oldness

Boolean
Oldness

Fred

3’ 2’’

0.00

0

27

0.21

0

Mike

5’ 5’’

0.21

0

30

0.29

0

Sally

5’ 9”

0.28

0

32

0.33

0

Marge

5’ 10”

0.42

0

41

0.54

1

John

6’ 1’’

0.54

1

45

0.64

1

Sue

7’ 2’’

1.00

1

65

1.00

1

Nonspatial Models
Boolean Logic

Fuzzy Logic

Truth (Marge is tall) = 0

Truth (Marge is tall) = 0.42

Truth (Fred is old) = 1

Truth (Fred is old) = 1

Truth (Sally is tall and old) = 0

Truth (Sally is tall and old) = 0.21

Truth (John is tall or old) = 1

Truth (John is tall or old) = 0.54

situations that can be true or false. Fuzzy logic allows degrees of truth
(expressed as a membership function) in the range of zero to one. In
this example, an expert uses fuzzy membership values to define the
importance of two characteristics of people (tallness and oldness) to
be used as predictive evidence (values between 0 and 1). The expert
also defines how the evidence is combined, in this example using
fuzzy AND and OR operators.
Probability is a special case of fuzzy membership. If the probability of truth is 0.8, then the probability of false is 0.2 (i.e., if the probability of an event occurring is x, then the probability of the event not
occurring is always 1-x). This additive-inverse property of probability
statements is not required in fuzzy logic. Fuzzy membership can be
thought of as the “possibility” that the statement is true.
In a Boolean model, the height of Marge (listed in Table 1) is
absolutely not tall or tallness is zero, whereas in a fuzzy logic model,
Marge’s height is somewhat short with a tallness of 0.42. Generally,

www.esri.com

Fuzzy logic provides an approach that allows
expert semantic descriptions to be converted
into a numerical spatial model to predict the
location of something of interest.
a membership of 0.5 indicates an ambiguous situation that is neither
true nor false. An example of a membership function with semantic
descriptors (e.g., possibly short, possibly tall) is shown graphically
in Figure 1. Fuzzy membership thus provides sensitivity to the subtle
aspects of the process being modeled. In addition, a variety of fuzzy
combination operators are available that greatly extend the simple
AND and OR operators used in Boolean logic and allow the flexibility
and complexity incorporated in making many real-world decisions to
be modeled.
Continued on page 10
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Continued from page 9

Fuzzy Tallness
True

1

Fuzzy Tallness

0.9
0.8

Possibly Tall

0.7
0.6

Uncertain

0.5
0.4
0.3
0.2

Possibly Short

0.1

False

0
20

30

40

50

60

70

Height (inches)

A Spatial Example
In a fuzzy logic model in ArcGIS, evidence rasters are assigned membership values with the Fuzzy Membership tool. Table 2 (on page 12)
defines the fuzzy membership functions available. Memberships are
combined using the Fuzzy Overlay tool to select a fuzzy combination
operator based on how the evidence interacts.
Table 3 defines five fuzzy operators. In a given model, different
operators may be used. These operators provide greater flexibility than
a weighted-sum or weighted-overlay model and let the expert incorporate greater sensitivity based on knowledge of how the evidence
interacts. In practice, operators for combining evidence are relatively
easy to select, but fuzzy membership may require some tuning of the
membership parameters to represent expert knowledge.

Table 3: Summary of fuzzy combination operators implemented
in the Fuzzy Overlay tool in ArcGIS 10. WHERE is the
membership value for crisp measurement x, and I indicates each
of the n evidence layers.

10 ArcUser Spring 2010

80

90

100

Figure 1: Graphic example
of the membership function
Tallness. The semantic
statement might be, “a
height of 82 inches is always
considered tall,” whereas
“a height below 38 inches
is never considered tall.” A
height of about 70 inches is
ambiguous for tallness and
given a membership value
of 0.5.5.

A Simple Expert Semantic Summary
Figure 3 is a simple example of a fuzzy logic spatial model. This geologic model for Carlin-type gold deposits uses datasets that are available with the Spatial Data Modeller tools (www.ige.unicamp.br/sdm/
default_e.htm). [Carlin-type gold deposits, with ore grades commonly
between 1 and 5 grams per ton, are primarily mined from open pits in
Nevada. They are named for the most prolific goldfield in the Northern
Hemisphere, the Carlin Trend Field.] From a semantic description of
the criteria for finding Carlin-type gold deposits, a simplified expert
semantic model might consist of the following statements:
 High values of antimony (Sb) or arsenic (As) are favorable for
Carlin-type gold. Use stream-sediment geochemistry to define a
mineralization geochemical factor.
 Host rocks of Carlin-type deposits are primarily Paleozoic and
Mesozoic dirty carbonate rocks. Use a geologic map to define a
lithologic factor.
 Dirty carbonate rocks are chemically low in potassium (K). Use
stream-sediment geochemistry to make a lithologic adjustment to
the mineralization geochemical factor. Elevated K differentiates
Carlin-type gold deposits from volcanic-rock-hosted gold deposits,
although both types are high in Sb or As.
From these semantic statements, a simple outline of the fuzzy logic
model can be defined.
A Simple Fuzzy Logic Model
Frequently such models have submodels or factors that describe complex aspects of the spatial model. These submodels often represent
factors defined by a single discipline; thus, “the Expert” for the entire
model is—in practice—often a team of experts who bring knowledge
from diverse fields when defining the decision process. A final model
is derived by combining the factors. The following semantic statements describe the process for determining the geochemical, lithologic-adjusted geochemical, and lithologic factors in the model shown in
Figure 3.

www.esri.com
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Reclass_kbge5
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1234

Float

Figure 2: Diagram of the Categorical Weights
tool available in the Spatial Data Modeller
toolbox
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Evidence
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Geologic-Map Evidence

Categorical

P

Categorical
Fuzzy
Membership

kbgeol3
Rock-Geochemical Evidence

Small 3,4

P

Geochemical Evidence

P

P

sbnb

Fuzzy
Membership (3)

Fuzzy Overlay
(3)

FuzzyMe_as_s1

Fuzzy Overlay

Carlin
Possibility

Lithologic-adjusted
Geochemical
Factor

Fuzzy Overlay
(2)

FuzzyMe_kjen2

OR

Mineralization
Factor

Figure 3: A demonstration of a simple fuzzy logic
model. Categorical membership is described in Figure
2. The other tools are Overlay tools in ArcGIS 10.

Large 4,5

Fuzzy
Membership

Gamma 0.9

AND

kjenks

Large 15,2

Fuzzy
Membership (2)

as_std

Lithologic
Factor

FuzzyMe_sbn10

Mineralization Geochemical Factor
Use the Large Fuzzy Membership tool for assigning fuzzy membership values to Sb and As. Tune the parameters for the Large Fuzzy
Membership tool to produce fuzzy evidence maps acceptable to the
expert.
Combine the Sb and As fuzzy maps with a Fuzzy OR operator. Use
the Fuzzy Membership tool for K, again tuning the parameters for the
Small Fuzzy Membership tool to make an acceptable map.

logic factor using the Gamma combination operator to produce the
Carlin-type gold possibility map. Tune the gamma parameter value to
produce an acceptable combination.
Once the model shown in Figure 3 is assembled, it will be
necessary to adjust the fuzzy membership parameters to tune fuzzy
memberships to represent properly the expert’s concepts. This tuning
can be done graphically in a spreadsheet or, more often, spatially by
inspecting rasters. Using iteration methods in separate tuning models
is useful for quickly computing a selection of rasters with a range of
parameters. Experts will recognize the best representation of the spatial data. When disagreements occur about the optimal tuning of the
fuzzy memberships, multiple models can be built quickly representing different opinions and tested during model validation. Figure 4
provides a comparison of the Boolean and fuzzy logic models. A
weighted sum model would be more similar to—but not the same
as—the fuzzy logic model.

Lithologic-Adjusted Geochemical Factor
Use the Fuzzy AND operator to combine the mineralization geochemical factor with the K membership.
Lithologic Factor
Assign the fuzzy memberships to the various lithologies present on the
geologic map following guidance from the expert and using the Categorical Fuzzy Membership tool in the Spatial Data Modeller toolbox
and diagrammed in Figure 2.
Combine the lithologic-adjusted geochemical factor with the litho-

Divisor

Geologic-Map Evidence

Categorical

P

kbgeol3
Rock-Geochemical Evidence

P

kjenks

FM_Cat

FuzzyMe_kje
n2
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Output Raster

OR

P
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Fuzzy
Membership (2)
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Large 15,2

FuzzyMe_as_
s1

Large 4,5

Fuzzy
Membership

FuzzyMe_sbn
10

Fuzzy Overlay
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Figure 4: The simple fuzzy logic
model for Carlin-type gold
deposits
Continued on page 12
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Membership Function

Description

Linear

A linear increasing or
decreasing membership
between two inputs. A
linearized sigmoid shape.

Definition

where min and max are user inputs

Large

Sigmoid shape where large
inputs have large membership

Small

Sigmoid shape where small
inputs have large membership

MS Large

Sigmoid shape defined by the
mean and standard deviation
where large inputs have large
memberships.

MS Small

Sigmoid shape defined by the
mean and standard deviation,
where small inputs have large
memberships.

where m = mean, s = standard deviation and b and a are
multipliers provided by the user.

where m = mean, s = standard deviation, and b and a are
multipliers provided by the user.

Near

A curved peak of membership
over an intermediate value.

Gaussian

A Gaussian peak of
membership over an
intermediate value.

Table of Contents
(TOC)

The experts can visualize the
membership values displayed
on the map.

Membership is defined based on the classes in the symbolization
in the Map document table of contents.

Categorical

Each named class is assigned
a membership value by the
expert.

Membership is defined by entering the values times a multiplier
into a reclassification table.

Somewhat

Applied to slightly adjust a
membership function.

Square root of membership.

Very

Applied to slightly adjust a
membership function.

Membership squared.

Table 2: Summary of fuzzy membership functions implemented in the Fuzzy Membership tool in ArcGIS 9.4. In addition, there are two hedges
(Somewhat and Very) that qualify the membership. These functions have been found most useful in spatial modeling problems. The first five
membership functions produce a sigmoid shape of the membership, which is used commonly in many fuzzy logic applications. Experience
with these functions can be gained rapidly by implementing them in a spreadsheet and adjusting the parameters.
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After completing the model or models, it is important to validate
the results. If there are known examples of what is being modeled
(i.e., known deposits, animal sightings), these can be used to test how
well the model classifies known examples. The Area Frequency tool
in the Spatial Data Modeller toolbox provides a measurement of the
efficiency of prediction measure. Lacking known examples, the judgment of the experts and field testing are required to validate the model.
For more information, contact Gary Raines at garyraines.earthlink.net.
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Boolean and fuzzy logic models. The model uses Bitwise OR and
AND in place of Fuzzy OR and AND. The fuzzy gamma is replaced
by a Bitwise OR, which is most similar to a fuzzy gamma.

www.esri.com

ArcUser Spring 2010 13

The Next
Generation of GIS
Dealing with design
and space-time

The rapidly changing nature and scale of
problems such as global climate change and
the widespread failure of the banking system
threaten to overwhelm the resources of individual nations and defy the methods of traditional science. However, leading researchers
and practitioners of geospatial technology
believe a new generation of GIS is evolving
that will help understand and address these
problems far more effectively.
Many of these leaders were recently
brought together for a pair of related
meetings held at the ESRI headquarters in
Redlands, California. The first event, the
2010 GeoDesign Summit, was sponsored by
the University of California, Santa Barbara;
the University of Redlands; and ESRI. It was
held January 8–10. More than 170 academics
and professionals met to discuss GeoDesign,
a new GIS field that marries the original
conceptualization of GIS by Ian McHarg as
a tool for designing the human environment
with the natural one with the more familiar applications of GIS for data collection,
creation, and management; data analysis; and
decision support.
As ESRI president Jack Dangermond
noted when introducing keynote speaker
Thomas Fisher, this new field is exciting because it creates a “continuum between measurement and design.” Fisher, the dean of the
College of Design, University of Minnesota,
approached the topic from the design side
rather than the GIS side. He emphasized that
14 ArcUser Spring 2010

GeoDesign should fulfill the real mission of
design, which is “making things work better
in the world,” particularly as related to sustainability and social justice issues rather than
just making things look more attractive, the
popular impression of what design does. He
also recognized that GeoDesign has a strong
temporal element because it brings together
geography, which looks at the “way the world
is and was,” with design, which looks at the
way the world might be, connecting the past,
present, and future. Also, he noted, geography
and design both are fundamentally spatial
disciplines.
Fisher said that historically, society has
been designing without a lot of information on consequences—consequences to the
environment, other people distant in time or
space, and other species. The focus has been
almost exclusively on fulfilling present needs.
As GeoDesign can bring data to bear on these
decisions “it will profoundly change the way
we live and the way we inhabit the planet.”
(For more information on the GeoDesign
Summit, see “Designing GeoDesign: Summit
on new field that couples GIS and design,” on
page 16 of this issue.)
Developing tools for dealing with largescale, complex problems was also the impetus
behind the Space-Time Modeling and Analysis Workshop. Thought leaders from seven
countries, who work in academia, government, and industry, met February 22–23,
2010, to share current work being done on

this aspect of geospatial technology and
develop an agenda for defining research areas
and designing spatiotemporal tools going
forward.
This workshop, cosponsored by the Association of American Geographers (AAG),
the University of Redlands, the University of
Southern California, and ESRI, was the first
Redlands GIS Week event. The workshop
included keynote presentations, Lightning
Talks, and breakout sessions that identified
the most important challenges and immediate
strategies for incorporating space-time into
GIS processes.
In his Keynote Address, Michael F.
Goodchild, professor of geography at the
University of California, Santa Barbara, and
director of spatial@ucsb, observed that while
“we have been talking about spatiotemporal
analysis modeling for a number of years, we
are now at a bit of a tipping point where we
can really start making progress.”
Spatiotemporal tools are “a way for looking at spatial data that will help us deal more
effectively with the complex problems we
now face, like climate change and economic
meltdowns and infectious disease, that don’t
allow for a leisurely, reflective approach to
solving them.”
The geospatial approach has become
more valuable because the role of the scientist
and science in society have changed. The
era of the lone scientific investigator is over.
Discoveries about complex systems require
www.esri.com
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teams of researchers who need powerful data
acquisition and management systems coupled
with sophisticated tools for handling both
space and time.
Goodchild also believes that science must
have a more active role in society and engage
with policy making. To do this, the scientific
community must package the results of science for general consumption. GIS is well
suited to the task of bringing all the pieces
of scientific understanding together in a way
that can be comprehended by the public to
influence policy. Policy and public interest
are driven by change. This means getting and
holding the public’s interest is difficult with
static maps. Incorporating the time dimension
in GIS will make it more captivating.
In addition, every major issue has an associated time scale. Climate change occurs over
decades, climate tipping points over years,
and economic meltdowns occur in a matter of
months, while infectious diseases span weeks
and disasters are framed in days. The analysis
and response to events has to speed up and
occur in near real time.
One approach Goodchild suggested for
developing spatiotemporal tools in GIS was
to consider space-time as a collection of
“sandboxes” or domains based on the tools,
data, and assumptions of the team working
in that area. How many areas or sandboxes
are there? He introduced seven sandboxes for
examining application areas for space and
time. His remarks served as a starting point
for much of the discussion over the following
two days.
Workshop presentations explored the
wide-ranging work being done across many
fields, particularly transportation and health.
David Maidment, director of the Center for
Research in Water Resources, University
of Texas at Austin, described the ambitious
work of the Consortium of Universities for
the Advancement of Hydrologic Science,
Inc. (CUAHSI) on space-time for hydrology.
CUAHSI represents more than 100 universities that develop infrastructure and services
that advance hydrologic science and promote
education in this area.
Integrating GIS, which describes the water
environment of watersheds, streams, gauges,
and sampling points, with water resources
observation data that describes the water itself
and consists of measurements such as flow,
water level, and concentrations, is made most
challenging because this observation data is
not standardized at all.
“Connecting GIS data with observational
data is connecting space and time,” said
www.esri.com

Maidment. The point water observations time
series CUAHSI developed combines a point
location in space with a series of values in
time and uses WaterML invented by CUAHSI
for transmitting water data on the Internet.
Using Web services, the consortium has the
world’s largest water data catalog, which
accesses 4.3 billion data values. This system
lies over existing water data systems and
allows them to be seen as a whole. CUAHSI
built a hierarchy of concepts to reconcile the
meaning of variables used in observational
data so data can be located without requiring
special knowledge of the naming conventions
of each organization that might supply that
observational data.
In closing, Maidment identified the complex challenges of space-time. He noted that
time is subtle: although it’s really continuous,
the data collected about time is discrete. Time
stamps play a key role, and time has dimensions (e.g., hour, day, month) that interact.
Finally, time has two forms—Universal Time
(UTC), which is like geographic coordinates,
and local time, which is like projected coordi-

nates. He concluded that space-time reference
frames and tools for moving data between
them were needed.
The GeoDesign and spatiotemporal tools
being developed will magnify the impact
of GIS on society’s understanding of the
world that can inform human behavior to
act in a more sustainable manner. As Paul
Torrens, an associate professor in the School
of Geographical Sciences at Arizona State
University and director of its Geosimulation
Research Laboratory, has observed, “This
is a wonderful time to be working with or
developing geographic information technologies, at the cusp of some very exciting future
developments that will bring GIS farther
into the mainstream of information technology and will infuse geography and spatial
thinking into a host of applications.” The
current integration of design and space-time
into GIS processes and software represents a
significant step in the ability of GIS to enable
geographic knowledge.
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GeoDesign
Next Steps in GeoDesign
GeoDesign—as a discipline, a field of study, and a
practice—continues to evolve. Several action items were
identified by the end of the 2010 GeoDesign Summit to
help further this evolution including
 Obtain a broader consensus. Everyone is invited to
participate in this discussion at participatorygeodesign.
ning.com/ and en.wikipedia.org/wiki/GeoDesign.
 Identify the new geospatial functionality, tools, and
technologies needed to support broader adoption of
GeoDesign.
 Hold a GeoDesign Challenge, with a cash prize, to
encourage the development of real-world geodesign
projects.
 Publish a book of GeoDesign case studies.
 Determine the optimal methods of teaching design
principles to geospatial professionals and develop a
GeoDesign curriculum.

More than 170 academics and professionals from fields
such as geography, architecture, GIS, urban planning,
engineering, conservation, and forestry attended the 2010
GeoDesign Summit held on the ESRI Conference Center in
Redlands, California.

 Hold another GeoDesign Summit in early 2011 to review
the progress made.
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Summit on new field that couples GIS and design
By Carla Wheeler, ArcWatch Editor
Although the word GeoDesign and its definition may be newly coined
and evolving, ESRI president Jack Dangermond observed that the concept of incorporating geographic knowledge into design isn’t new as he
addressed attendees at the world’s first GeoDesign Summit in January
2010.
“GeoDesign is going on. It has been going on for hundreds of years,”
he said, pointing to examples in farming, urban planning, and site selection for stores. For example, farmers have always taken geography into
account when deciding what crops would be appropriate to grow on
their land and where to locate their farms (e.g., near a water source for
irrigation).
Dangermond and a group of thought leaders from academia and
a variety of professions believe it’s time to better integrate geospatial
technologies such as GIS with design to deal with the planet’s most
pressing problems. To jump-start that process, the 2010 GeoDesign
Summit, sponsored by the University of California, Santa Barbara; the
University of Redlands; and ESRI, was held January 8–10 at ESRI’s
conference center in Redlands, California. More than 170 academics
and professionals from fields such as geography, architecture, GIS,
urban planning, engineering, conservation, and forestry attended the
event. Besides listening to keynotes and Lightning Talks (i.e., presentations lasting only a few minutes) on GeoDesign and how it’s being
used, attendees participated in “idea labs” for creating agendas for topics such as GeoDesign theories, education, future technologies, 3D visualization, and analysis in design.
The Wikipedia entry they created to define GeoDesign reads, in part:
“GeoDesign is a set of techniques and enabling technologies for planning built and natural environments in an integrated process, including
project conceptualization, analysis, design specification, stakeholder
participation and collaboration, design creation, simulation, and evaluation (among other stages).”

Thomas Fisher, dean of the College of Design at the University of
Minnesota, spoke passionately about the need for geodesign in his
Keynote Address.
The entry continues with a quote from “GeoDesign: Fundamental
Principles and Routes Forward,” the presentation Michael Flaxman
made at the summit: “GeoDesign is a design and planning method which
tightly couples the creation of design proposals with impact simulations
informed by geographic contexts.”
“We are at the beginning of what many of us see as a new field,” said
Thomas Fisher, dean of the College of Design at the University of Minnesota, in his Keynote Address. With the world facing what he called
“exponentially increasing stress on the systems we depend on” such as
natural ecosystems and building infrastructure, there’s a great need to
use spatial data and technologies in planning and design to tackle problems such as those associated with global warming, threats to species,
and poorly designed infrastructure.
Continued on page 18
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Designing GeoDesign
Continued from page 17

“One of the powers of GeoDesign is it makes these problems visual,” he said. “They are easier to ignore when they are abstractions. Because we have been designing the world without data-rich knowledge
of consequences, we’ve created a situation where we’ve made ourselves
vulnerable as a species, which to me gives urgency to GeoDesign. This
is something we don’t have a lot of time to develop.”
The purpose of the two and a half day summit was to
 Define and formalize the term GeoDesign and its methodology.
 Promote and advance GeoDesign research and education.
 Discuss how to go about creating better GeoDesign technologies
and tools.
 Talk about how to more deeply couple design with GIS and other
geospatial technologies.
 Prepare a set of use cases to show what GeoDesign can accomplish.
In his opening remarks, Dangermond spoke about the great potential
for GeoDesign, which is described by some as a pairing of design and
GIS. It unites the art and creativity of design with the power and science
of geospatial technology. GeoDesign can produce more informed, databased design options and decisions.
“The notion of integrating these two fields is very exciting to me.
We have a kind of continuum from measurement to making decisions
that integrates all of our ways of doing things into new processes,”
Dangermond told the gathering.
Dangermond said accelerating improvements in geospatial technologies will hasten advances in GeoDesign. New design-friendly capabilities and tools in the upcoming release of ArcGIS 10 will help
professionals apply GeoDesign methodologies to problems and challenges related to anything from climate change to pandemic diseases,
environmental protection to food production, and resource conservation
to infrastructure improvements.

The virtual city template, available with the ArcGIS 3D Analyst
extension at ArcGIS 10, provides a useful example of a
well-defined 3D city. It was demonstrated during the summit.

“Geospatial technology is migrating to the Web and will be used by
practically everyone in some way or other,” Dangermond said. This new
style of serving geography will affect virtually everything that people
do—not just a few researchers, GIS professionals, or those who work
with geographic information. Improvements in GIS, the explosion of
location-based services (LBS), faster computers, more bandwidth and
storage, the boom in mobile devices, and the emergence of cloud computing will also speed GeoDesign along, according to Dangermond.
While some people describe this as disruptive technology, for
Dangermond, “it’s just another step in the evolution in the enabling
technology that allows us to bring these new ideas that will come out
of this meeting to fruition. Organizations also are beginning to serve
geographic knowledge, which is providing a new infrastructure to build
on top of, hopefully, the design notions that come out of the summit.”
Dangermond continued, “Agencies will not be providing data files or
maps. They will be providing services, and these services will be a new
framework. Just like the Apple iPhone is providing a framework for
all kinds of apps, these geospatial services—and the ability to build
creative applications on top of them—will explode our field and the
general interest in designing our future.”
Designer-Friendly GIS Technology
Matthew Baker, Nathan Shephard, and Bern Szukalski from ESRI demonstrated currently available tools and services and soon-to-be-released
technology that will assist designers in their work.
Baker’s demonstration focused on the modeling, sketching, and
feedback capabilities in ArcGIS Desktop 10, set for release in the second quarter of 2010. To find the best areas suitable for redevelopment
in Detroit, Michigan, he created a model that used public GIS data and
extracted block group parcels in the city that met criteria such as high
poverty rates, vacant properties, and high unemployment. He used
basemaps available from ArcGIS Online, an ESRI Web site that provides free maps and other resources for GIS applications.
The model’s results pointed Baker to key redevelopment areas.
Baker then began sketching a new neighborhood using standard landuse symbols for neighborhood design, which will be available in future
templates in the ArcGIS 10 editing tools. He received instant feedback
on the suitability of his designs in the form of pie and bar charts that
were based on the features he sketched using an ArcGIS 10 add-in
called the Dynamic Charting tool. Every time new features are added to
the map, the Dynamic Charting tool provides updates.
Shephard demonstrated new design-friendly capabilities in the
ArcGIS 3D Analyst extension to ArcGIS Desktop 10. These capabilities included template-based (sketch) editing in 3D; 3D vector analyses
of line of sight; 3D object intersections and skylines; volumetric analysis of buildings, shadow impact, and visibility zones; and a template of
a virtual city. The virtual city template provides a useful example of a
well-defined 3D city. The four key elements of such a city are a topographic basemap, high-resolution imagery, an elevation surface, and 3D
buildings. If the data is available, users can add other elements such as
vegetation, streetlights, and park benches.
“These new capabilities allow you to quickly and accurately solve
3D GIS problems, such as assessing the impact of a proposed building
on your city or identifying areas of concern based on 3D topography,”

18 ArcUser Spring 2010										

www.esri.com

Focus

“As GeoDesign can bring data to bear on those design decisions,
it will profoundly change the way we live and inhabit the planet.”
—Thomas Fisher, Dean of the College of Design at the University of Minnesota

said Shephard.
Szukalski showed the audience ArcGIS Online resources for
GeoDesigners or Web mappers that serve as what he called an “excellent substrate” of content. “These new basemaps and others provide
great maps you can use as is or to represent a great canvas for design or
GIS work,” said Szukalski. These resources include
 The updated World Imagery map, which compiles the best available
imagery for the United States and many cities around the world including London, England, and Geneva, Switzerland
 Bing Maps for enterprise, aerial, hybrid, and roads
 The new World Street map, which includes building footprints for
major cities around the world
Urgent Need for GeoDesign
The summit brought together thought leaders in GIS, architecture, design, conservation, and many other fields including Michael Goodchild,
professor of geography at California State University, Santa Barbara;
Carl Steinitz, research professor at the Graduate School of Design, Harvard University; Kim Tanzer, dean of the School of Architecture at the
University of Virginia; and William B. Rogers, president and CEO of
the Trust for Public Lands. They spoke on how GIS is being used in design today and on its great potential to integrate the creativity of design
and the science of GIS.
Fisher from the University of Minnesota spoke passionately of the
urgency of the situation. Citing ideas put forth by the Pulitzer Prizewinning author Thomas Friedman and professor of psychology David
Barash at the University of Washington, Fisher argued that humans
have created a giant Ponzi scheme with the planet over the last several
hundred years, sucking resources and exploiting labor to maintain a
certain way of life.
This has led to the creation of what Fisher described as “fracture-critical systems” like the one that led to the collapse of the
Interstate 35W bridge in Minneapolis, Minnesota, in 2007. Other fracture-critical threats include the exponentially increasing atmospheric
carbon accumulation and rapidly declining biodiversity.
“Even the recent financial crisis grew out of a fracture-critical
system,” Fisher said. “We designed financial products such that we
increased the debt . . . where a few investment banks go down and
they bring the entire global financial community down with [them],”
Fisher said. “It’s a classic collapse of a fracture-critical system. There
is a spatial component to this. The banks do not know where the debt
lies. Here, too, GeoDesign can help us understand the flows of money
spatially across the planet.”
Fisher called a fracture-critical system a metaphor for the world

humans have designed for themselves. But he pointed out that innovations such as GeoDesign can help reverse the course. “A lot of what we
have been designing—our cities, our buildings, our landscapes—have
been designed without a lot of information about the consequences of
our actions on other species, on distant populations, on future generations,” he said. “As GeoDesign can bring data to bear on those design
decisions, it will profoundly change the way we live and inhabit the
planet. Through innovation, we can rethink the way in which we inhabit
the planet, we can rethink the way we use resources, and we can prolong our ability to sustain ourselves. GeoDesign’s time has come, and

it’s none too soon.”
Dangermond concurred. “We need this right now,” he said. “We need
to not only understand what’s occurring on the planet, but we also need
to take more proactive involvement in designing what occurs. Then we
have to promote those designs, those creations, those in our mind’s eye
expressions, to the rest of society. That’s the challenge.”

www.esri.com										

ArcUser Spring 2010 19

The Role of Volunteered Geographic
Information in a Postmodern GIS World
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The rising interest in compiling georeferenced
data has manifested itself in the growth of volunteered geographic information (VGI) Web
sites. This is an assertive method of collecting
geospatial information as opposed to the authoritative method employed by government
agencies and private industry. Wikimapia, a
site that encourages participants to post comments about georeferenced locations, is a good
example of VGI. On the Flickr Web site, users
can upload photos related to specific locations,
while OpenStreetMap is an international effort
to create a free source of map data through the
efforts of volunteers.
ESRI writer Jim Baumann recently interviewed Michael F. Goodchild. Goodchild is
professor of geography and chair of the executive committee of the National Center for
Geographic Information & Analysis (NCGIA)
at the University of California, Santa Barbara (UCSB) and director of the Center for
Spatially Integrated Social Science (CSISS),
a research organization at the university, and
associate director of the Alexandria Digital Library Project. He has been involved in the VGI
movement and has written extensively on it.
Baumann: Gazetteers have traditionally been
essential in collecting and distributing geographic information. Now there is a groundswell of people participating in Web-based
20 ArcUser Spring 2010

social networking sites and contributing volunteered geographic information. These sites
can be viewed as asserted gazetteers in what
might be described as the democratization
of geographic data. Please discuss what the
GIS community gains (and loses) from this
phenomenon.
Goodchild: Although gazetteers (the names
layer) are important for many reasons, and increasingly so, they have never included more
than the officially recognized names that appear on maps. Names that are not officially
recognized, such as “downtown Santa Barbara,” and names that are meaningful to local
communities, such as “the Riviera” [the hilly
area of Santa Barbara north of downtown], do
not appear in any gazetteer. This limits many
applications, for example, making it difficult
to build GPS navigation systems that recognize the full range of place-names that people
need to use. Moreover, the official mapping
agencies are not likely to invest in adding
such names to their gazetteers anytime soon.
However, place-names are one of the most
successful forms of volunteered geographic
information, and people are clearly willing
to spend time providing them to Web sites.
Volunteered gazetteers can provide much
richer descriptive information than before; allow features to have multiple names; and include names for the smallest, least significant
features.
What do we lose by relying on volunteered
place-names? I think one major problem is
lack of accuracy, whether by accident or design. But a more significant problem concerns
preservation. National mapping agencies can
devote significant resources to preserving
place-names, ensuring that future generations have access to today’s data, but no such
mechanisms exist for volunteered geographic
information. Once the initial enthusiasm has
worn off, who will undertake the tedious task
of updating and preserving?
Baumann: Do you see assertive and authoritative spatial data working together, in parallel, or in opposition to each other?
Goodchild: I think the best option is to make
them complementary, and there are already

signs that the traditional authorities are willing
to work with citizens. In the UK [United Kingdom], for example, the Ordnance Survey has
developed a program that encourages volunteers to provide geographic information about
their local communities, and volunteers are
playing an increasingly important role in ensuring that authoritative sources of geographic
information are accurate and kept up-to-date.
Baumann: What role does VGI play in societal GIS? How will it help shape the evolution
of GIS?
Goodchild: One of the criticisms leveled at
GIS has been its insistence on a single point of
view. VGI is, in a sense, postmodern GIS, in
which individuals are able to assert their own
views of their surroundings and play a part in
local decision making. Another criticism was
the tendency of GIS to empower those who
could afford its high costs and marginalize
those who could not. I think that by engaging
citizens in the process of acquiring and using
geographic information, VGI has the potential
to alter this landscape significantly and soften
some of these criticisms.
Baumann: While Wikimapia has genuine potential, it seems to be populated with some
information that is not particularly useful or
interesting. However, I do think that it can be
a valuable resource. For example, obscure yet
relevant information that might otherwise be
lost could be posted and contribute to our collective body of knowledge. You mentioned that
you think the benefit of sites like Wikimapia
will be in the compilation of local data. Please
expand on this observation.
Goodchild: Wikimapia demonstrates what
is possible in a general sense, but I think the
eventual value of sites like Wikimapia will be
much more specialized. I’m thinking of local
community groups and their need to acquire
and share descriptions of their communities for
specific purposes such as planning, networks
for hobbyists who need to acquire and share
highly specialized geographic information, or
sites that might be developed by local communities to provide information for tourists.
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Baumann: Marshall McLuhan’s view of the
Global Village is often used to describe the
World Wide Web. What is required to nurture
a problem-solving geospatial initiative on the
Web that would take a leading role in our virtual world community?
Goodchild: Geospatial data and tools are essential in almost everything we do as humans,
and over the past few years, they have become
accessible to virtually all of us on the wellendowed side of the digital divide. We have
seen volunteer initiatives, such as MapAction
and the GISCorps, playing an important role
in disaster response and other volunteer activities that are providing open sources of basic
map information in communities that have
never previously had access. I think the most
significant new opportunity lies in the fact that
a substantial fraction of the human population
now has access to mobile phones and, hence,
to electronic networks. I think mobile phones
could be used to acquire and share damage
assessments in the immediate aftermath of a
disaster and to develop detailed databases for
community planning. Project GLOBE has
already shown the potential for empowering
schoolchildren worldwide as environmental
sensors; a new initiative, sponsored by a major foundation, could explore the potential of
a much more powerful and comprehensive
approach that would reach beyond the digital
divide.
Baumann: “The bad invariably pushes out
the good” is an axiom that has been applied
to various disciplines. How true do you think
that is when it comes to data quality in VGIbased initiatives? What will happen if individuals or groups subvert, either consciously or
simply through a lack of attention, VGI-based
projects? For example, you have mentioned
a nonexistent café that was geographically
referenced to the park in front of the Santa
Barbara mission.
Goodchild: The experience of Wikimapia
seems to be that accurate, large-scale information resources can be created from volunteer
action. Wikimapia’s accuracy varies and is
most problematic for the more obscure entries
that are not accessed very often. Similarly, I
think VGI will be most accurate when it concerns the largest, most prominent, and most
important features on the earth’s surface. The
message in my example of the nonexistent
café is that such errors are particularly obvious when the information is geographic, because they conflict with the feature’s spatial
www.esri.com

context. Wikimapia relies on volunteers with
specialist knowledge to monitor information;
a similar approach to geographic information
that relied on local specialists could work very
well to clean out errors.
Baumann: You indicate that “computerization carries authority per se.” This perceived
authority has been ascribed to other forms
of mass media including print and broadcast
journalism. The Fourth Estate refers to the
press and its ability to both function in the
role of advocate and shape public opinion.
Do you think VGI and other public mapping
efforts play a similar role? When considering
the pitfalls of these efforts, Google’s controversial replacement of post-Katrina images of
New Orleans with pre-Katrina views springs
to mind.

Goodchild: Yes, I think there is a tendency
to believe what one discovers on the Web,
whether the source is authority or assertion.
Bad information can always be dressed up to
look good. We usually think of metadata as
the mechanism for resolving such problems,
but asserted sources rarely carry any metadata.
Somehow, we need to convince sources such
as Google that providing simple metadata,
such as the date of acquisition of imagery,
would be in everyone’s interests.
For more information on this topic, see
Goodchild’s 2007 paper on VGI, “Citizens
as Sensors: The World of Volunteered Geography,” which is available online at www.
ncgia.ucsb.edu/projects/vgi/docs/position/
Goodchild_VGI2007.pdf.
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Geoenabling Federal Business Processes
Improving services to citizens through place-based approaches
By Sarah Hammer, Jessica Zichichi, and the Geo-Enabled Business Work Group

Have you ever wondered about the quality of
the air and water in your community or what
types of toxins you may be exposed to? Have
you wanted to learn if adverse environmental
factors were present near a home you are considering purchasing?
While the answers to these questions
would seem to require extensive research
across numerous sources, Environmental Protection Agency (EPA) uses geospatial technology to deliver the environmental information
that answers these and other questions using
a single, easy-to-use online interface called
MyEnvironment.
MyEnvironment is a Web-based mapping
application that provides data on environmental conditions from numerous federal, state,
local, and private sources. The site incorporates mapping technologies and georeferenced
data to organize and display everything from
Superfund sites and other facilities that report
to the EPA to daily ultraviolet (UV) indexes
and local water quality data. Users can find
personalized information by searching by ZIP
Code or address. MyEnvironment links directly to relevant data sources and presents the
information in several formats, such as maps,
reports, and charts.
MyEnvironment is just one example of
how federal organizations are geospatially
enabling their business operations. Many federal agencies are using geospatially driven approaches similar to the one used by the EPA
for performing business processes and accomplishing mission goals. These agencies often
face common challenges: coordinating across
programs, combining numerous sources of
information, and addressing reductions in
budget and personnel. Geoenabled innovations throughout the federal government have
helped agencies streamline mission-critical
functions, saving resources and improving
results while, at the same time, empowering
individuals to learn about issues facing their
communities. This article provides an overview of some geospatial projects implemented
at federal agencies as a way to provide insights
into the trends, challenges, solutions, and resources that could be leveraged by GIS users
across the nation.
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MyEnvironment links directly to relevant data sources and presents the information in
several formats, such as maps, reports, or charts.
Raising Awareness
GIS analysts working outside the federal government may not be aware of the types of geospatial applications and data that are available
and may not see how the work of government
agencies relates to their daily lives or jobs. In
particular, the work of cross-agency federal
initiatives, such as the Geospatial Line of Business (Geospatial LoB), may not be visible to
nonfederal GIS personnel because these efforts
tend to focus on coordinating the activities of
federal partners. However, initiatives such as
the Geospatial LoB are focused on coordinating the production, maintenance, acquisition,
information architecture, and use of geospatial
data to reduce the cost of federal government
programs; inform decision making; and, at the
same time, improve services to citizens.
As key stakeholders in this endeavor, the

public should be made aware of the Geospatial LoB efforts to maximize the value of
geospatial investments. The Geo-Enabled
Business (GEB) Work Group, an integral
part of the Geospatial LoB, is composed of a
number of federal agency representatives who
volunteer their time to assist federal program
managers and executives in identifying their
geoenabled business needs, capabilities, and
opportunities. The GEB Work Group meets
regularly to identify new geoenabling opportunities and document existing examples
that may provide a foundation for expanding
knowledge about the capabilities, benefits, and
applicability of geospatial technologies for addressing federal agency business functions.
The agency-specific stories and examples provided in this article, collected from
Geospatial LoB partners, illustrate how
www.esri.com
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geospatial resources, approaches, materials, or
products developed by federal agencies may
be leveraged or reused by the public to meet
different needs.
To determine how geospatial technologies and approaches are used within the federal government to carry out its business,
Geospatial LoB team members assembled
use cases profiling federal programs or projects that leverage geospatial technology successfully and productively meet internal
needs or provide information to the public.
Interviews were conducted with members of
the U.S. EPA, the U.S. Department of Agriculture (USDA), the U.S. Department of Justice (DOJ), the Bureau of Land Management
(BLM), the Federal Emergency Management
Agency (FEMA), the U.S. Geological Survey
(USGS), and the National Oceanic and Atmospheric Administration (NOAA).
Information collected from these groups
was analyzed to identify common themes,
approaches, and lessons learned. For more information on a particular example, contact the
authors. The article concludes with an overview of where Geospatial LoB is headed.

NOAA mission goals: protecting national
safety, serving society’s needs for weather
information, and supporting the nation’s commerce. For NOAA, GIS created value by enabling an integrated, authoritative, Web-based
source for information on coastal conditions
that is easily accessible for the public, commercial purposes, and federal users.
A different type of information consolidation is the development of the Common Land
Unit (CLU) dataset by the USDA Farm Service Agency (FSA). FSA created the CLU as
a comprehensive digital dataset that includes
millions of farmland boundaries obtained
from paper maps in more than 2,300 offices.
The CLU helps FSA carry out mission-critical
functions, including compliance and conservation, by combining digital farm boundaries with business data. The consolidated data
helps FSA meet its mission goals while saving
the agency time and resources.
Improving and Streamlining Operations
The TERRA program, also created by the
USDA FSA, combines 27 formerly indepen-

dent calculations and pieces of information
into one geoenabled application. TERRA
helps FSA weigh the costs and benefits of renting land from farmers to stop soil erosion—a
mission-critical function that is part of the
Conservation Reserve Program. Both farmers
and staff members use this database to quickly
visualize areas of protected land and improve
decision making. Calculations that may have
taken days in the past now take only minutes.
Another example of streamlining processes
is the National Institute of Justice (NIJ) Mapping and Analysis for Public Safety (MAPS)
program at DOJ. Through the MAPS program,
NIJ created a range of geospatial tools that focus on mapping incidents of crime to better inform police investigations and actions. These
tools provide a number of functions ranging
from hot spot analysis, journey to crime estimation, and near-repeat calculations. MAPS
tools support DOJ’s mission by improving the
ability of law enforcement professionals to
fight crime while simultaneously providing resources that support researchers studying law
enforcement and crime.
Continued on page 24

Examples of Geospatial Enabling
A list of geoenabled use cases is summarized
in Table 1. To highlight trends and application
areas, use cases are organized into six categories: consolidating information, improving
and streamlining operations, increased sharing
and interagency coordination, automating and
improving adherence to standards, providing
GIS toolkits and suites of services, and including stakeholder outreach and input.
Consolidating Information
A key characteristic of GIS technology is its
ability to bring data and information together.
Many agencies leverage GIS to combine data
from disparate sources to serve specific, mission-oriented goals. For example, NOAA created nowCOAST, a geoenabled Web site that
provides access to real-time coastal data. This
site brings together georeferenced information
from numerous federal agencies, NOAA’s internal resources, and 15,000 external sources.
Providing timely information on coastal and
climatic phenomena directly supports three
www.esri.com

The nowCOAST Web site provides access to real-time coastal data from numerous federal
agencies, NOAA’s internal resources, and 15,000 external sources.
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Geoenabling Federal Business Processes
Continued from page 23

Increased Sharing and Interagency Coordination
In addition to time and cost savings, many
organizations use geospatial technology to
facilitate inter- and intra-agency coordination.
Enterprise Geospatial Services (EGS) facilitates spatial data sharing across FEMA by actively managing data collection, storage, and
use. EGS facilitates data sharing between offices within FEMA and with other agencies,
which curbs the tendency to create information silos within a branch or section.
BLM developed the National Integrated
Land System (NILS) GeoCommunicator to
coordinate geographic data from numerous
groups (internal, federal, and state agencies
and tribal and local entities). Information compiled in NILS furthers cooperation across offices and assists in making land-use decisions.
Additionally, EPA Metadata Editor (EME) fosters increased sharing of geospatial resources
through better-quality metadata. This freely
available application encourages users both
inside and outside the federal government to
produce high-quality, reusable metadata that
can be shared with others. [For more informa-

EPA Metadata Editor (EME) fosters increased sharing of geospatial resources through
better-quality metadata.
tion on EME, see “The EPA Metadata Editor”
in the July–September 2007 issue of ArcUser
magazine, which is available online at www.
esri.com/arcuser.] The coordination and sharing of information exemplified by these applications not only reduces redundancy but also
provides decision makers with better access
to higher-quality information and encourages
agencies to coordinate their efforts to solve
complex problems.

The National Integrated Land System (NILS) GeoCommunicator, developed by the Bureau
of Land Management (BLM), coordinates geographic data from internal, federal, and state
agencies and tribal and local entities.

Automating and Improving Adherence to Standards
As agencies work together, providing data and
services to one another, adhering to standards
becomes increasingly important. One agency
tackling standards related to address information is the Department of Housing and Urban
Development (HUD). HUD uses geospatial
data, especially address information, in its everyday operations and decision making. The
agency’s Geocode Service Center (GSC), a
core part of its geospatial infrastructure, is a
cost-effective solution that ensures the consistency and accuracy of address information
for more than 17 data systems. GSC services
are also used at HUD to validate addresses
and match the same addresses within different
datasets. GSC’s high data standards have ensured data consistency across HUD programs
and serves as a model for other agencies. The
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Agency

GIS Application

Web Site

Bureau of Land Management

National Integrated Land System (NILS)
GeoCommunicator

www.geocommunicator.gov

Department of Housing and Urban
Development

Geocoding Service Center (GSC)

www.huduser.org/datasets/usps/
USPS_Data_Dictionary.pdf

Department of Justice, National Institute
of Justice

Mapping and Analysis for Public Safety
(MAPS)

www.ojp.usdoj.gov/nij/maps/

Environmental Protection Agency

EPA Metadata Editor (EME)

www.epa.gov/geospatial/eme.html

Environmental Protection Agency

MyEnvironment

www.epa.gov/myenvironment/

Federal Emergency Management Agency

Enterprise Geospatial Services (EGS)

www.gismaps.fema.gov

National Oceanic and Atmospheric
Administration

nowCOAST

nowcoast.noaa.gov/

U.S. Department of Agriculture

Common Land Unit (CLU) Dataset

www.fsa.usda.gov/FSA/apfoapp?
area=home&subject=prod&topic=clu

U.S. Department of Agriculture

Tool for Environmental Resource Results
Assessments (TERRA)

www.fsa.usda.gov

U.S. Geological Survey

Geospatial Management Information
System

www.usgs.gov/science_strategy/

Table 1: Federal geospatial innovations
EPA also uses EME to ensure high-quality
data inside the agency. EME creates metadata
that adheres to the FGDC Content Standard
for Digital Geospatial Metadata.
Providing GIS Toolkits and Suites of Services
Many federal agencies provide value to their
users by developing toolkits or suites of services. With these suites, users can access
many geospatial tools easily. DOJ’s MAPS,
for example, provides law enforcement professionals and researchers with a complete
desktop-based geospatial crime analysis kit.
It contains two complete desktop geospatial
systems, two profiling utilities, a crime analysis extension, a tactical crime analysis tool,
linked charting programs, statistics programs,
and a complete office program suite. In addition, NIJ provides Web-based crime tracking
and prevention tools to augment the desktop
software. FEMA also provides a variety of
geospatial services to its users, including professional services such as geospatial project
management, technical training, and systems
engineering.

Including Stakeholder Outreach and Input
Many organizations recognize the crucial role
that stakeholders have in creating and implementing a successful geospatial program or
project. Numerous agencies reported utilizing stakeholders throughout the requirements
gathering, application design, and development phases of application development.
Several agencies continue to work actively
with stakeholders to improve these geospatial applications. For example, while creating
the CLU database, designers consulted FSA
staff from offices around the country, key
decision makers, and even farmers to create a
tool that would assist in capturing CLU data
and performing the functions FSA needed.
NOAA, EPA, and U.S. Geological Survey
have included stakeholders throughout collaborative design and implementation.

critical for creating a sustainable, geoenabled
future. The Geospatial LoB will continue
working with partners to identify existing and
new areas where geospatial technology may
be expanded, reused, consolidated, and leveraged. For more information on the Geospatial
LoB and its structure, visit the FGDC.gov
Web site and read the Geospatial Line of Business fact sheet (www.fgdc.gov/geospatiallob/factsheets). To become involved or learn
more about the Geospatial LoB, contact Lew
Sanford at lsanford@usgs.gov.

Conclusion and Next Steps
As these examples show, geospatial technology has become a core component of federal
government mission operations. Expanding
GIS technology in a way that realizes the best
value for the government and the public is

Jessica Zichichi is a senior geospatial consultant at Innovate!, Inc., and supports the Geospatial LoB. She has been working in the field of
GIS for more than 10 years and holds a master’s
degree in computer science and bachelor’s degrees in geography and environmental studies.
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Getting Answers Quickly
Hydrologic analysis and 3D GIS improve flood response
By Vinu Chandran, Seth Agyepong, and Tim Scharff, Cobb County GIS

A map of Cobb County
showing flooded creeks,
stream gauges, watershed
boundaries, and flooded
parcels

A flowchart showing the data
processing steps in flood analysis
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A three-dimensional view of the flooded area showing stream centerlines and elevation
In September 2009, torrential rains in the
northern portion of Georgia caused excessive
runoff, triggering massive flooding in several
areas. Flooding principally affected Cobb,
Fulton, and Douglas counties and caused nine
deaths and approximately $250 million in
property damage.
Cobb County, in northern Georgia,
with a population of approximately 700,000,
experienced heavy flooding along the banks
of Chattahoochee River and various major
creeks. Hundreds of houses and families in
southern and southeastern Cobb County were
affected. County and federal governments and
relief organizations played an important role
in rehabilitating affected areas by providing
emergency response, shelter, and postdisaster
support.
Part of that support came in the form
of geospatial modeling within an enterprise
GIS environment. Established in 1999, Cobb
County’s enterprise GIS was an integral part

of the county’s Emergency Operations Center
(EOC). At the EOC, GIS staff collected data
from damage assessment teams and staff
members supporting the center, created data
layers, performed analyses, and produced
maps in response to several requests for
information.
Away from the EOC, GIS staff in
different departments coordinated with the
EOC to create data layers and produce maps,
such as the road closure maps generated by
Cobb County Department of Transportation.
To focus immediate assistance where needed
most, identification of the flood-affected
properties was important. Flood analysis
carried out by the GIS group and the tax
assessor’s office benefited different departments that were working to provide a fast
and effective response and mitigation after
the event. The flood inundation analysis was
carried out with stream gauge measurements
from the United States Geological Survey

(USGS) and spatial data contained in the
county’s enterprise GIS.
The main objectives of the analysis were
to identify the approximate extent of floodwater coverage; identify and locate the affected
parcels; determine the minimum, maximum,
and mean water heights in the parcels; and
identify and document completely and partially flooded properties. The analysis used
three data sources: maximum stream gauge
readings at select locations, a high-resolution
elevation surface derived from the county’s
digital terrain model (DTM), and the parcel
database. All vector and raster data analyses
were carried out in ArcGIS Desktop because
it has the vector, raster, and three-dimensional capabilities needed to complete the
analysis. Apart from the routine analysis, the
hydrologic analysis tools helped in the faster
delineation of watersheds, whereas the 3D
capabilities helped in visualizing the output.
Continued on page 28
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Getting Answers Quickly
Continued from page 27

base in ArcSDE as well as tables in a CAMA
(computer-assisted mass appraisal) system
that contains ownership, property classification, and valuation information for more than
248,000 parcels. Each record in the parcel
geodatabase and CAMA table is identified by
a unique parcel number, which was used to
link these tables to obtain the ownership and
property class information.

Aerial photos of a subdivision in Cobb County before (top) and after (bottom) the flood

Calculating the Flood Extent
Runoff water from a hydrologic unit (watershed) is always drained to a particular stream.
Thus, the stream floods the area within its
watershed. The flooded areas in the county
were divided into six watersheds for flood
boundary calculation. Watershed boundaries were derived from a resampled (32-foot)
sink-free DEM using the Hydrology tools in
the ArcGIS Spatial Analyst extension. U.S.
Geological Survey stream gauge sites were
visually identified from the orthophotos. The
ground elevation (m-values measured in feet)
at these locations were obtained from the
DEM. The flood boundary was calculated by
determining the maximum flood elevation in
feet (H) for a watershed, then identifying the
areas in the DEM having values less than H.
The maximum flood elevation is calculated
as where SG is the maximum stream gauge
reading in feet.

H = M + SG

Determining the Flood Boundary
Deriving the flood boundary as fast as possible was the main goal of the EOC request.
Necessary modifications were made to the
flood boundary using the field observations.
The corrected flood boundary was then used
to identify inundated parcels.
Stream gauges served as the primary
source of water level information during the
flood event. Readings from seven gauges
located on various streams/rivers were used
to determine the elevation of floodwater at
these locations. The crux of any terrain-based
analysis is a three-dimensional representation of the terrain. Hence the accuracy of
the output is highly dependent on the terrain

model. A highly accurate digital elevation
model (DEM) with a horizontal resolution of
8 feet, which was derived from the county’s
2-foot contours and stored as a float doubleformatted raster image, is available from the
county’s enterprise GIS data warehouse. To
verify the flood boundary and make corrections during field verification, the original
2-foot contour data was used. A line feature
class of the streams was used to identify the
stream centerlines and names. Orthophotos
and oblique aerial photography were used
in conjunction with photographs taken from
aircraft to verify the flood boundary and the
floodwater heights at known locations.
The county maintains a parcel geodata-

Inundation areas were calculated separately
for each watershed. The DEM grid (8-foot
resolution) clipped by watershed boundary,
was level sliced to identify the area below the
maximum flood elevation. The flood cover
raster was then converted to a polygon feature
to obtain the flood boundary. For generating
the preliminary flood boundary, slope of the
streams was not taken into account. Modifications were made to the flood boundary using
observations from the field. Flood boundaries
from all the watersheds were then combined
into a single polygon.
The flood-affected parcels were identified by intersecting the flood boundary with
the parcel feature layer. Parcels completely
falling within the flood boundary were classified as fully inundated. The minimum,
mean, and maximum floodwater heights for
each parcel were calculated by estimating the
respective elevations from the DEM (using
the zonal statistics tool), according to the following formulas on page 29.
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The pie chart shows the percentage of the county’s 3,794 properties that were affected by the flood. The chart inset shows the percentage of
residential properties under different floodwater levels. The photograph shows a section of Six Flags theme park that flooded.

Hmin = 0 or H - Mmin if H > Mmin
Hmean = 0 or H - Mmean if H > Mmean
Hmax = 0 or H - Mmax if H > Mmax
Where Hmin, Hmean, and Hmax are the minimum, mean, and maximum water heights and
Mmin, Mmean, and Mmax are the minimum,
mean, and maximum ground elevation values,
respectively.
The formulas above are used for calculating
floodwater heights for each parcel.
The parcel feature table was then joined
with the ownership table to obtain the parcel
class (e.g., commercial, residential, public
www.esri.com

property). ArcScene was used to generate a
three-dimensional visualization of the flooded
area. The field inspectors were provided with
situs addresses along with the flood height
information for the parcels. This information
helped them easily identify and determine
the extent of damage for each property. The
county has since established a river model in
HEC-RAS to help ensure future flood inundation boundaries can be obtained with better
accuracy. [HEC-RAS, or the Hydrologic
Engineering Center’s River Analysis System,
is a software program developed by the U.S.
Army Corps of Engineers for performing
one-dimensional steady flow, unsteady flow,
sediment transport/mobile bed computations,
and water temperature modeling.]
Information is the lifeline of any EOC,

and GIS technology is a valuable tool when
it comes to managing and analyzing data and
ensuring its broad availability. Through the
use of GIS, Cobb County was able to quickly
determine the approximate extent of flooding;
generate maps and reports that helped first responders, inspectors, and repair crews prioritize the areas to visit; and publish information
to department managers and personnel via a
Web mapping application.
For more information, contact
Tim Scharff, GISP, GIS Manager, at tim.scharff@
cobbcounty.org
Seth Agyepong, GIS Supervisor, at seth.
agyepong@cobbcounty.org
Vinu Chandran, GIS Specialist, at vinu.
chandran@cobbcounty.org
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The Virtual Estuary

New GIS tool for exploration and analysis
By Sandra Fox, St. Johns River Water Management District, and Stephen Bourne, PBS&J
A GIS tool developed by a team of experts is
helping scientists more effectively study complex coastal and estuary systems.
Coastal flooding from extreme weather
events threatens millions of lives and properties along U.S. coastlines every year. Especially hard hit are areas along the Atlantic
Ocean and the Gulf of Mexico where over
60 percent of homes and businesses are within
500 feet of the shoreline. Yet, the ability to explore and study complex coastal environments
with accuracy and speed has been limited, if
not impossible. Affordable hydrologic models that work well on inland studies simply
don’t translate to coastal applications. However, more sophisticated supercomputer-based
modeling techniques are cost prohibitive.
In a pioneering effort, the St. Johns River
Water Management District (SJRWMD) led a
team of experts from academia, government,
and industry in the development of the Analytical Framework for Coastal and Estuarine
Studies (ACES) GIS tool, one of the first
comprehensive coastal and estuarine tools.
Still under development, ACES is designed
to help scientists accurately monitor and
manage the health of a complex estuary from
within the Arc Hydro hydrologic environment. [Arc Hydro is a data model template
for use with water resources applications that
has been developed by ESRI in collaboration
with key state, national, and international
contributors.]
This tool has been used to support estuarine and coastal studies for the Guana/
Tolomato/Matanzas Estuary, also a National
Estuary Research Reserve for SJRWMD, as
well as water quality studies in the Gulf of
Mexico. [The National Estuarine Research
Reserves are “living laboratories” that help
researchers better understand coastal communities and find methods for dealing with the
challenges these areas face.]
Cooperative Development
SJRWMD is responsible for regulating water
use and protecting wetlands, waterways, and
drinking water supplies along Florida’s sensitive eastern coastline from Fernandina Beach to
Vero Beach. The agency’s Surface Water Quality Monitoring (SWQM) has used Arc Hydro to
develop specialized hydrologic tools such as an
automated pollution load screening model and
a drainage area spatial data summary tool.

In this portion of the estuary displayed in ArcScene, the high tide polygon (red line) and low
tide polygon (solid dark blue) along with a digital elevation model (DEM) of the area
Yet, while greatly beneficial, these hydrologic tools were unable to account for tidal influences, which directly impact water quality
in estuarine waters. This limited the agency’s
ability to accurately manage water quality
throughout the region.
SJRWMD put together a technical team
to develop ACES that included experts from
SJRWMD, University of Florida, The Nature
Conservancy, U.S. Geological Survey, and
PBS&J, a consulting firm. The agency also
put in place an expert review team that would
be responsible for evaluating the end product
developed by the technical team. The review
team included the members from the Center
for Research in Water Resources at the University of Texas, Austin; U.S. Army Corps of
Engineers’ Engineer Research and Development Center; and PBS&J.
The technical team’s first task was to establish a master plan for the tool development from proof of concept to production.
SJRWMD stipulated that the tool must be applicable to all SJRWMD estuaries and include
existing GIS-based tools and enhanced Arc
Hydro geodatabases developed by SWQM.
Goal-driven brainstorming sessions helped
keep the technical team on track through-

out the development process. The initial
brainstorming sessions and literature review
focused on the nature of an estuary, estuarine
hydrodynamics, estuarine classification, existing GIS-based modeling technologies for
estuaries, and synthetic modeling of water
quality in estuaries.
The team found that the first step in approaching the study of estuaries was the creation of a GIS-based workbench tool that could
integrate multiple sources. Water in coastal
areas frequently comes from multiple sources. These might include surface water flow,
incoming tides, manmade waterways, and
even in some cases groundwater. The tool had
to allow for the creation of virtual estuaries and
estimation of bulk parameters of the estuaries
and facilitate development and integration of
other models into the same framework.
Conceptual Controls
In the initial development phase of the ACES
project, the technical team developed an estuary control volume conceptual model that connects features in the estuary physical model
with elements contributing to the control volumes such as waters from coastal bases, oceanic constituents, riverines, and intracoastal
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waterways. Groundwater influence was not
considered in this initial application since the
influence is likely small as compared to the
other elements.
The team relied on a simple multiple linear regression (MLR) tool for evaluating relationships between constituents emanating
from drainage areas and the measured values of water quality in the control volume.
A more robust estimate of contributing areas
may be obtained by using an iterative process
that compared predicted and measured values
while modifying the drainage area contribution. Throughout the effort, the team communicated extensively regarding various topics
ranging from the deceptively simple, such as
the definition of an estuary, to the complex and
controversial modeling approach.
Coastal Possibilities
The ACES prototype tool is composed of a GISbased database of spatial and temporal data that
describes the environment and an accompanying ArcMap-based toolset. Using ACES, scientists can essentially build a virtual model of the
estuary they are interested in using topographic,

The St. Augustine Inlet to the Guana/
Tolomato/Matanzas Estuary is a barrier that
was accurately characterized with the ACES
tool. The Matanzas Inlet is one of Florida’s
few remaining natural, unmanaged inlets.

bathymetric, and tidal datum data.
Within an Arc Hydro model, ACES can be
used to determine estuarine bulk parameters
(such as total area, high and low tide, volume,
depth, and tidal flow) related to the shape of
the estuary. With data related to flow rates into
and out of the estuary, more complex parameters can be derived, such as residence time (the
time water stays within a system) and flushing
potential (an estuary’s ability to flush a harmful substance).
Using this information, the relative importance of tidal versus land-based flow on
estuarine hydrodynamics can be assessed.
Relationships between estuary water quality
and flow rates can also be investigated. Using the ACES regression model capabilities,
scientists can find the correlative relationships
between the influential factors of upstream riverine drainage, coastal drainage, and estuarine
non-point source pollution.
Prototype in Action
An ACES prototype was used to support estuarine and coastal studies for the Guana/
Tolomato/Matanzas Estuary, which is also
a National Estuary Research Reserve for
SJRWMD. Guana/Tolomato/Matanzas encompasses approximately 73,000 acres of
salt marsh and mangrove tidal wetlands, oyster bars, estuarine lagoons, upland habitat,
and offshore seas in northeast Florida. Along
the northern section of the reserve, the Tolomato and Guana rivers meet the waters of the
Atlantic Ocean. The southern section follows the Matanzas River, which extends from
Moses Creek south of Pellicer Creek.
The ACES tool was also used to support a
water quality study of Copano Bay in south
Texas, a project sponsored by the Texas Commission on Environmental Quality. A popular fishing and recreation site, Copano Bay
is a large watershed with source waters from
Aransas Bay and several rivers. Dr. Stephanie
Johnson, then a doctoral student in the Center
for Research in Water Resources at the University of Texas under Dr. David Maidment,
wanted to develop an accurate water quality
model for the bay. Johnson had already acquired estuary depth measurements, which she
converted to volumes to model the processes
within the bay.
“To complete this study, I needed basic information, such as the bay volume and symme-
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ACES was used to find the volume of Copano
Bay in Texas at several tidal levels to
estimate pollutant loadings in the bay. Each
colored polygon shows the shoreline for a
different water level.
try, which I could have calculated by hand using
available contour maps, though it would have
been a tedious process,” said Johnson. Working
with the ACES development team, Johnson used
the ACES program to automatically develop the
necessary estuary volume versus depth curve for
use when computing the total maximum daily
load of pollutants. “Through the ACES program,
I was also able to create highly visual images
that I incorporated into my larger water quality
model and used to communicate with various
nontechnical stakeholders,” added Johnson.
In the near future, environmental scientists
at SJRWMD will use ACES to explore the estuaries along the northeastern coast of Florida,
including the mouth of the St. Johns River,
the Indian River Lagoon, and the Nassau and
St. Marys rivers. ACES presents a wealth of
possibilities for the exploration and analysis of
estuaries at universities and within water management districts. This tool will continue to
evolve in functionality and application to help
coastal experts more easily explore and understand complex coastal environments.
About the Authors
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Is ONE
Route Good
Enough?
Using ArcGIS Network
Analyst in pipeline
alignment optimization

By Ahmad M. Salah, Ph.D., GISP,
and Denis Atwood, P.E.

Pipelines are considered by some to be the most cost efficient
and environmentally friendly method for transporting oil, gas,
water, and other fluids. The continued growth of municipal areas
is increasing the demand for pipelines. However, the high cost
of building pipelines and the potential devastation that can be
caused by pipeline failures require that these projects be thoroughly planned.
Most pipeline alignment tasks involve linking the conduit
from an origin point to a destination point. In some applications,
more than one origin and destination may be required for the
same alignment. Between the origin and destination points, decision makers are always confronted with numerous and a sometimes seemingly infinite number of potential corridors from
which to choose.
Pipeline alignments have been designed using many methods ranging from filling out simple and subjective forms to employing sophisticated GIS tools. The ArcGIS Network Analyst
extension can be used for performing spatial analysis on linear
networks. Node-to-node routing, one of the types of analysis that
can be performed using Network Analyst, minimizes an objective function (i.e., define the shortest route).
Having said that, is producing one “best” route the most
32 ArcUser Spring 2010
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The decision matrix breakdown
desirable result for all applications? Depending on the network, a significant number of
potential routes may be possible. Depending on the specific network problem being
considered, a single best solution may not be
the most feasible or useful. For example, the
third best route from a cost perspective may
be the best when considered from a maintenance or environmental perspective. Decision makers often like to consider multiple
options before coming to a final decision
on the selected route, especially for significant and large diameter pipelines. For these
reasons, modelers typically generate more
than just the default “best” route. Selecting
more than one default route using ArcGIS
Network Analyst can be done both manually
and programmatically.
This article summarizes the use of
ArcObjects and Visual Basic for Applications
(VBA) to develop a custom application for
pipeline alignment optimization that can identify a number of potential routes and list and rank
these routes for further analysis in an automated
fashion. The application extracts project-specific information, including segment weights and
costs from a Microsoft Excel spreadsheet, and
imports them as attributes to a pipe network
www.esri.com

feature class composed of individual pipe segments. The application loops through the potential corridors to list a predetermined number
of potential routes. A feature class listing these
corridors is generated and displayed. The application then exports the output back to Microsoft Excel and ranks the corridors according to
their total weight (summation of weights for the
comprising segments) and costs and generates a
graph illustrating all the generated corridors in a
triaxial chart for quick analysis of the potential
routes.
This application uses a pipe segments feature class in which the segment IDs are stored
as integers in a field named SgID. It also uses a
decision matrix, a two-dimensional table listing
all segments available between origin and destination points and their scores for each criteria
and subcriteria included in the analysis. The decision matrix is created in Microsoft Excel. Decision makers and stakeholders use Excel when
developing project priorities, defining project
design criteria, assigning relative weights to criterion, and assigning a score for each segment
for each criterion. This is a preprocessing tool
that aggregates all factors into two numbers—
weight and cost. Weight combines all segment
weighted scores on all criteria, while cost com-

bines the associated costs for each segment.
Engineering, environmental, and socioeconomic factors are considered in the decision
matrix. Each segment is given a score on each
of these factors along with the relative weights
between these criteria. The weighted score for
both weight and cost is calculated for each segment. The lower the value assigned to the segment, the more desirable the segment would be
for the pipeline corridor.
Engineering considerations include land
uses, terrain, materials, constructability, rightof-way acquisition, crossings and conflicts,
soils, geology, length, and operation and
maintenance.
Environmental considerations include land
use, visual and physical impacts, National
Environmental Policy Act (NEPA), permits
(for departments of transportation or local and regional agencies, or for Section 404
[permits issued pursuant to Section 404 of
the Clean Water Act, which regulates the discharge of dredged, excavated, or fill material in
wetlands, streams, rivers, and other U.S.
waters]), and site conditions.
Socioeconomic considerations include business and residential impacts, agency consider-
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The process for importing segment weights
and costs
Continued on page 34
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Is One Route Good Enough?
Continued from page 33
ations, and construction time.
Once the pipe network is identified and the
decision matrix is populated with the relative
scores and weights for all the segments and
criteria, the application is ready for the analysis. The analysis process consists of three
steps:
1. Import segment weights and costs into
ArcGIS.
2. Identify potential corridors.
3. Export results back to Microsoft Excel.
Optimizing a corridor from a nest of segments is similar to finding the directions
through a network of roads—at least one attribute is required for the optimization process.
Minimizing an objective function is the key to
determining the best route. In this analysis, two
attributes are used: total segment weight and
cost.

Once the decision matrix is populated with
criteria weights and segment costs and scores
for all criteria, it is important to import the segment weight and cost into the Pipe Segments
feature class in ArcGIS. From ArcGIS, the application lets users browse for the Microsoft
Excel decision matrix. Once the file is opened,
the application looks up the segment weights
and costs for each segment based on segment
ID in the segments feature class and reads the
data from Microsoft Excel cells, which contain
weight and cost. The application highlights
each cell in the decision matrix to indicate is
has been successfully read.
The application then appends three fields
to the Pipe Segments attribute table. The
SgLength field contains the length of each segment in map units, which is feet. The SgWeight
field contains segment weights imported from

the decision matrix. The SgCost field contains
segment costs imported from the decision matrix. However, if these fields exist before the
application runs, the values in these fields are
just updated.
Once the individual segments', weights
and costs are imported from the decision matrix, the application is ready to perform the
Network Analyst process. The application loops
through the segment feature class and identifies
all potential routes from the start node to the
end node(s). The algorithm for this command
minimizes the total weight of the segments
comprising the current corridor. It does not take
the cost of each segment into consideration in
selecting the corridor but does keep track of the
cost and sums it for each potential corridor.
After successfully identifying routes, the
application generates a new feature class and

Test case pipe network feature class with 79 segments, one origin point
(point 1), and two destination points (points 2 and 3)

An example of the best of the top 31 routes selected in an application run
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Feature

Corridor ID

A ranked list of corridors

Total weight

Sum of the weights of all the segments that comprise a corridor

Subtotal Costs

Sum of the costs of all the segments that comprise the corridor

Segments

An ordered list of all the segments comprising the corridor

Triaxial Summary Chart

Representation of the total weight as bars and subtotal costs as lines

Table 1: Fields exported to the Best Corridors worksheet
adds it to the active data frame in ArcGIS. The
new date- and time-stamped feature class is
saved in the application’s Model Output folder.
Each feature in this file is a potential pipeline
route between origin and destination points.
The number of potential routes is determined
by the preset number of iterations.
In summary, successful corridor identification requires
 A polyline feature class for the pipe segments
 A segment feature class with three fields
named SgLength, SgWeight, and SgCost
 ArcGIS Network Analyst extension loaded
and an active ArcGIS Network Analyst
window
Each route can be viewed in ArcGIS geographically and exported to CAD, if desired.
Also, the application reads the values from the
attribute table of the output feature class and
exports it to Microsoft Excel. In Microsoft Excel, the file contains only one worksheet named
Best Corridors and a chart. Both can be saved if
desired. (See Table 1)
The application also generates a summary
report for each run, if it's present in a dialog,
and a Microsoft Word document that lists
 The date and time of the application run
 The spatial data path
 Feature class used
 Geodatabase used (with path)
 Shapefile projection
 Shapefile alias name
 The modeler ID
 Number of fields and records in the used
shapefile
 Total number of features selected
While one “best route” may be sufficient in
some cases, for most pipeline applications, a
list of the top 20 routes will help decision makers arrive at a more well-informed choice. Because building transmission pipelines requires
a large time investment and can have significant environmental and socioeconomic effects,
determining pipeline routes deserves detailed
analysis. This application can save time by automatically providing a list of potential routes.
For major pipelines, the involvement

of the public and other stakeholders in the
decision-making process is paramount.
The decision matrix and the dynamic process described are very useful. Stakeholders,
agencies, and the public can be involved in
assigning weights and scores to segments. Once
that is done, the application can be run and,
within a short time, a chart can be generated
that ranks the top potential routes. Once a good
algorithm is defined, automated route generation saves a lot of modeling time.
By programmatically linking ArcGIS to
Microsoft Excel/Word and/or CAD for further
analysis and reporting, the application provides
a user-friendly interface embedded into ArcGIS

www.esri.com										

that lets users go through the optimization process. The linkage tool took about two weeks to
program, test, and implement. The authors anticipate this tool will be used in future pipeline
alignment projects.
For more information, contact
Ahmad M. Salah, GIS Specialist
Stanley Consultants
383 W. Vine Street, Suite 400
Salt Lake City, Utah 84123
E-mail: salahahmad@stanleygroup.com
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Illustrating the Value of GIS
ArcGIS Explorer as a marketing and decision-making tool
By Kevin Willis, Lake County GIS Director
The Lake County GIS Division wanted to better inform the public about how and where GIS
technologies are contributing to the county in
a positive manner. The division also wanted to
encourage county departments to evaluate how
GIS can add value in new areas. The division
decided that ArcGIS Explorer is the tool for
better educating others about the value of GIS.
Lake County, located in central Florida,
northwest of Orlando, has 1,156 square miles
of which 203 square miles, or 17.58 percent,
is water. Historically a rural area, Lake County
has experienced more than a 25 percent population growth rate from 2000 to 2006. According to U.S. Census Bureau estimates for

ArcGIS Explorer, which can be used to
create mashups of map services and local
data, was used in the creation of a video that
demonstrates how Lake County uses GIS to
benefit county operations.
2006, it was ranked as the 23rd fastest growing
county in the United States with a population
approaching 300,000. This growth has caused
the county to struggle to maintain and expand
its infrastructure.
This situation provided an opportunity
for the county to explore ways for taking advantage of GIS. GIS technologies are not just
leveling the playing field; they are leveraging it
by adding value through identifying cost savings and allocating resources more efficiently.
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GIS is helping people make better decisions.
Lake County GIS uses a hybrid approach
to data sharing and data custodianship. Using
this approach, non-GIS staff are trained to use
GIS technologies at a basic level within their
departments. These users, or GIS liaisons,
are mentored by the GIS Division staff. This
model extends the county’s use of GIS and allows the GIS staff to focus proactively on data
analysis and modeling tasks. Over the past
two years, the Lake County GIS enterprise
environment has initiated many solutions that
address real-world issues. GIS-enabled solutions enhance the level of service the county
provides to citizens through cost savings, data
analysis, and project modeling and visualization and can leverage county resources to provide risk management benefits.
Explaining what GIS is and its benefits
to someone who lacks a technical background
can make for a long conversation. Lake County GIS needed a way to demonstrate the value
of GIS and educate others in understandable
terms and avoid spiraling into a technical
abyss of deep explanations. Because a picture
is “worth a thousand words,” a video presentation seemed the appropriate medium for
broadening GIS awareness.
Lake County GIS decided ArcGIS
Explorer could best communicate visually
how GIS is adding value across county business functions because it can demonstrate
through real-world examples how GIS technologies are providing exceptional benefit to
the public. Both data providers and consumers
of data could learn how GIS can better provide
services to their customers.
Using ArcGIS Explorer, Lake County
GIS has created a short video called GIS
Technologies: Leveraging the Playing Field
that highlights the county’s local data holdings and applications and includes embedded
video, graphics, and text. The audio narration
describes how GIS is being implemented in
the county to make better decisions. The video had its premier showing during the Lake
County GIS Day event in November of 2009
and was placed on the Lake County GIS home
Web page so visitors can better understand
how GIS is used throughout the county.
This video is an excellent resource for
marketing to stakeholders, fostering cooperation, and creating partnerships with local
communities. ArcGIS Explorer is a superb
marketing tool for Lake County GIS. Powerful

and interactive ArcGIS Explorer presentations
can communicate geographically, in a near
real-time manner, what is occurring. The video
has raised awareness of the new Economic Development Property Finder application, which
was designed to attract new businesses and increase job opportunities within Lake County.
The video also shows how GIS technologies
contribute to local government business needs
through applications such as the Proposed Future Land Use Interactive Map. Lake County
also presented how GIS technologies assisted
with grant application efforts for both mapping and data analysis.
In addition to its role in creating the
video, ArcGIS Explorer helps citizens utilize
county GIS data for their specific needs. Its
easy-to-use and powerful interface, available
at no cost, can display scenarios and promote
informed decisions. ArcGIS Explorer integrates projects and programs effortlessly and
provides decision makers with a dashboard
perspective for quickly and clearly understanding information.
It is estimated that 80 percent of all
databases can be displayed visually. GIS
technology breathes life into Lake County’s
databases, which optimizes how and where
county resources produce the greatest return on
investment.
For more information, contact
Kevin Willis, GIS Director
kwillis@lakecountyfl.gov
View the video, visit the Lake County GIS
home Web page at
www.lakecountyfl.gov/departments/
information_technology/
geographic_information_services/
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Kevin Willis, GIS director, has an M.C.S.E.
certification and an M.B.A. in information
technology management.
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Getting Started with Geoprocessing
and ArcObjects in .NET
By Chad D. Cooper, GISP, Southwestern Energy Company

What’s that?

You say you want to do some geoprocessing and maybe even some ArcObjects programming using .NET, but just

aren’t sure where to begin? Visual Studio and the whole “.NET Framework” thing are somewhat
intimidating, aren’t they? If you are not a programmer by training, you sure can be. Namespaces, classes, assemblies, methods, references, solutions…
it’s enough to scare anyone not familiar with it. But have

running

with your very own

no fear. You

can be up

—yes you—

.NET geoprocessing application

and

in no time.

What You Will Need
• Notepad (or any text editor) and a command prompt.
• Microsoft .NET Framework 2.0 or higher (www.microsoft.com/net/).
• Microsoft Visual Studio 2005/2008 (Visual C# Express version available free at www.microsoft.com/express/download/).
• An ArcSDE connection, either enterprise or workgroup (optional).
• Exercise archive gpandnet.zip, downloaded from ArcUser Online. This archive contains the source code and the listings in a PDF for
easy reference when reading this article and the file geodatabase with the sample data.

Why Use the .NET Framework for Geoprocessing?
At ArcGIS 9.2, ESRI introduced the Geoprocessor .NET assembly,
which opened up the geoprocessing toolbox to .NET developers.
There are several reasons you might want to use the .NET Framework
for your geoprocessing tasks. Maybe your company’s IT department
is already a .NET shop. The .NET Framework is enterprise tested and
accepted. If you have non-GIS .NET developers, they can be a valuable resource to you when learning the ins and outs of .NET programming. .NET solutions are also extremely scalable. The entire library
of over 30,000 ArcObjects components is exposed to you (more on
this later), providing you have low-level access to the very objects that
the core geoprocessing tools and framework are built with. As we will
soon see, communication with the geodatabase is well integrated. Last
but not least, .NET applications are fast and efficient.

Getting Started
Before you proceed, you need to open the listing files in the exercise
archive downloaded from ArcUser Online so you can refer to them.
Next, verify that you have the Microsoft .NET Framework installed.
To find out if you have .NET Framework version 2.0 or greater
installed, go to C:\WINDOWS\Microsoft.NET\Framework. If you
have a v2.xx folder there, you already have the .NET Framework 2.0
installed (you may have several folders here, ranging from versions
1.x up to 3.5).
If you do not have a licensed version of Visual Studio 2005/2008
Professional, Microsoft provides a lightweight but fully functional
version for both the VB.NET and C# languages. To follow along with
the examples in this article, download and install Visual C# 2008 Express Edition. Installing Visual Studio 2005 (any licensing level) will
also install the .NET Framework 2.0, while installing Visual Studio
2008 (also any licensing level) will install the 3.x .NET Framework.
To make compiling at the command line a little easier, set up a
Continued on page 38
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User Environmental Variable on your user PATH to the .NET 2.xx
directory. This will allow you to run the C# command line compiler
from any directory with ease. Right-click My Computer, click the
Advanced tab, click Environment Variables, find the PATH variable
in the list of User variables, click edit, and add ;C:\WINDOWS\
Microsoft.NET\Framework\v2.x.xxx to the end of the existing PATH
variables list. Make sure you get the version correct, and don’t forget
the semicolon in the front to separate it from the previous environmental variable in the PATH list.
Hello World!
The .NET Framework supports both the Visual Basic and C# languages. For the purposes of this article, all code listings will be in C#.
There are a number of ways to write and compile .NET applications.
Writing your code in Notepad and compiling using the C# command line compiler is by far the simplest way of constructing a .NET
application.
Start Notepad (or your plain text editor of choice) and type the
code from Listing 1. This is a simple C# program that prints the classic “Hello world!” to standard output at the command prompt. Save
this file as HelloWorld.cs, where .cs is the file extension for a C# file.
In this example, I’m working in the directory I created at C:\testing\
csharp.
Before we can run our code, we must compile it into an executable file. To compile this example, we will use the C# command line
compiler. Assuming you have your PATH environmental variable set
up, open a command prompt window (Start > Run > type cmd), and
compile your code, as in Listing 2.
Typing csc calls the C# compiler, the /out: flag tells the compiler
where to put the output executable file, and the final argument we pass
in is our input C# file. Now, at the command prompt, navigate to your
executable’s directory and run it (as shown in Listing 3). Congratulations, you just wrote, compiled, and ran your first .NET program! Not
so hard, eh?
Stepping Things Up a Notch
The next section will get an Integrated Development Environment
(IDE) up and running. With the classic “Hello world!” under our belts,
let’s get down to business. Launch Visual Studio/Visual C# 2008 Express (which I will hereafter collectively refer to as just Visual Studio),
go to File > New Project, and select Console Application. Give your
project an appropriate name, click OK, and Visual Studio creates a
new solution for you that includes references to assemblies we will be
using and a C# file named Program.cs by default.
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Before we can use any geoprocessing tools (or any ArcObjects
components) in our program, we must add references to the proper
ESRI assemblies to expose those functionalities. If the Solution
Explorer pane is not visible in Visual Studio, go to the View menu and
select Solution Explorer. In the Solution Explorer, expand your projects tree and expand the References tree. You should see references
to several System assemblies that Visual Studio sets automatically for
you when it builds your solution. Right-click References and select
Add Reference.
The Add Reference window may take a few seconds to come
up, and when it does, select the .NET tab, scroll down through it and
examine the assemblies that are available to you, especially those that
begin with ESRI, as those are all the ESRI assemblies that contain the
geoprocessing and ArcObjects functionalities that we want to expose
for our use in Visual Studio. Select ESRI.ArcGIS.Geoprocessor from
the list and click OK. Notice that the assembly has been added to the
References in your project. Now let’s focus on Program.cs and writing
some code.
Writing Geoprocessing Code
To access the Geoprocessor object’s methods and properties, we still
need to do one more thing: add a using directive to our code. The
using directive has two uses: to permit the use of types and create an
alias for a namespace or a type. Every variable and constant has a
type, as does every expression that evaluates to a value in a namespace
(i.e., a collection of different classes), so you don’t have to qualify
the entire namespace. This will soon make more sense. In Program.cs
(which is where we will be typing from here on), on the line below the
current last existing using directive, type the following:
using ESRI.ArcGIS.Geoprocessor;

Add the following line inside your Main function, and instantiate (create an instance of) a Geoprocessor object:
static void Main(string[] args)
{
Geoprocessor gp = new Geoprocessor();
}

Note that as you started typing “geoprocessor”, Intellisense
kicked in and took you right to the Geoprocessor class in the
drop-down list of items available to you. Now, comment out using
ESRI.ArcGIS.Geoprocessor;. Do you notice that Geoprocessor loses
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its green color? Hover over it. Nothing, right? That’s because you just
removed its reference. Now add ESRI.ArcGIS.Geoprocessor. before
Geoprocessor, so you have this:
static void Main(string[] args)
{
ESRI.ArcGIS.Geoprocessor.Geoprocessor gp = new
ESRI.ArcGIS.Geoprocessor.Geoprocessor();
}

You now have effectively fully qualified the entire namespace
and told Visual Studio where to look for the Geoprocessor class. You
can use whichever method you choose. However, the first method,
employing the using directive, seems to be the preferred method and
is the method I will employ in the examples here. Next, add a new
line and type gp.;. You should get an AutoComplete list with all the
Geoprocessor methods that are now available to you. Pretty nice, eh?
Now that we have a Geoprocessor object available to us, let’s put
it to use on a small, simple file geodatabase of Arkansas data that I assembled from Geostor (geostor.arkansas.gov) and the U.S. Geological
Survey National Hydrography Dataset (nhd.usgs.gov). Listing 4 goes
into every geodatabase in C:\Data and prints the feature class names to
standard output. This is not very useful by itself, but getting access to
datasets is crucial to virtually all geoprocessing tasks.
There are several different ways to execute your program. To run
your program from within Visual Studio (also known as “debugging”),
go to Debug > Step Into or press the F11 key. This will start your
program in the Main() method. Once there, press F10 to step through
your code. Notice that a command prompt window gets launched, and
any Console.Writeline() statements get printed to this. Another way is
to build your application (Ctrl + Shift + B or Build menu > Build Solution) to an executable file (.exe), open a command prompt window
and navigate to the Debug directory where your compiled executable
is stored by default. (My Debug directory is C:\VS\ArcUserArticle\
Geoprocessing\GpExample\GpExample\bin\Debug)
Run the executable. Listing 5 shows how to run the executable
(by navigating to the directory, typing the executable’s name, then
pressing Enter) and the results you will get. Compiling an executable
and running it from the command line is a common method of running
.NET console programs. You can easily schedule processes this way
through Windows Scheduled Tasks or an enterprise scheduler.
Performing Basic Geoprocessing Tasks
Now that we have created a Geoprocessor object, set up a workspace

Figure 1: Adding assembly references to your project
on our file geodatabase, and iterated through the feature classes in the
geodatabase, let’s see how to set up and perform some basic geoprocessing tasks with ArcToolbox tools. First, it is important to note that
any geoprocessing tool available to you in ArcToolbox is available to
you programmatically through .NET—all you need to do to get access
to a tool is add a reference to its assembly, or toolbox.
To do this, in the Solution Explorer in Visual Studio, right-click
the References folder of your project and select Add Reference.
Scroll down until you start seeing ESRI assemblies. What you get
should resemble Figure 1. The assembly ESRI.ArcGIS.DataManagementTools is the assembly that houses all the tools available to us
in the Data Management toolbox in ArcToolbox. To expose assemblies for use in your solution, you would add references to ESRI.
ArcGIS.Geoprocessor, ESRI.ArcGIS.Geoprocessing, ESRI.ArcGIS.
DataManagementTools, and ESRI.ArcGIS.AnalysisTools, then add
them using directives for each assembly to your program file.
To illustrate how to programmatically set up tool inputs and
outputs, let’s perform some relatively simple geoprocessing tasks—
selecting, clipping, buffering, and exporting—on our file geodatabase
feature classes. Along the way, we’ll also do some logging to a text file.
For more information on accessing the geoprocessor from C#,
see the post “Overview of accessing geoprocessing functionality” at
Continued on page 40
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the ArcGIS Resource Center (resources.esri.com) and “Executing
geoprocessing tools” (resources.esri.com/help/9.3/ArcGISEngine/
dotnet/43d8cc77-5193-4ca8-9878-6027782e2bbb.htm), both available
from the ArcGIS Resource Center for Geoprocessing.
Listing 6 is a program that performs basic geoprocessing tasks
on feature classes in the ArkansasData file geodatabase. This listing is
verbosely commented, so I won’t go into the details. Essentially, we
go into the streams polyline feature classes, select all the perennial
streams that intersect the city limits polygons, clip those streams to the
city limits, sum up the stream lengths for each new feature class, and
write those results to a text file.
If you need to process every feature class in your geodatabase,
you could employ the code in Listing 4 and use it to dynamically fetch
the list of feature classes for iteration at run time instead of explicitly
listing your inputs as is done in Listing 6 on lines 27–28.
Working with ArcSDE
So far we have worked with file geodatabases, but what about ArcSDE
(both Enterprise and Workgroup)? Let’s dig a little deeper into using
ArcObjects in .NET by connecting to instances of Enterprise ArcSDE
running on SQL Server (2005, in this case) and Workgroup ArcSDE
running on SQL Server Express 2008. (Apologies to those working
in Oracle shops: I don’t have access to an Oracle ArcSDE instance
to test against.) For more information on connecting to geodatabases
(including Oracle ArcSDE), see the article “How to connect to a
geodatabase” (resources.esri.com/help/9.3/ArcGISEngine/dotnet/
c778d2bb-eb36-4793-9c89-20795811c5eb.htm) available at the
ArcGIS Resource Center for Geoprocessing.
Connecting to ArcSDE generally entails setting up your connection properties, using those properties to open up a workspace within
the geodatabase, then opening a feature dataset within that workspace.
Listing 8 shows how to connect to Enterprise ArcSDE on SQL Server
2005 and Workgroup ArcSDE on SQL Server Express 2008. Note
the similarities in the connection properties between Enterprise and
Workgroup ArcSDE. Also note that opening up the database for either
instance uses the same code—only different connection properties. If
you are unsure of any of the connection properties you need, ask your
database administrator.
Working with ArcGIS Server
The ESRI.ArcGIS.Server assembly exposes hundreds of methods we
can use to interact with ArcGIS Server. Using ArcObjects, we can connect to ArcGIS Server and get a list of running services. Listing 9 is a
simple example showing how to connect to an ArcGIS Server instance
and return a list containing each service along with its status (as illustrated in Listing 10). Keep in mind that the account this process runs

40 ArcUser Spring 2010

on must have the required privileges to access your ArcGIS Server
instance.
A script written by Sam Berg of ESRI, called AGSSOM, is an
excellent example of how to use ArcObjects to more fully interact
with ArcGIS Server. AGSSOM can be found on the ESRI ArcScripts
site (arcscripts.esri.com/details.asp?dbid=16293).
Documentation, Help, and Additional Resources
ESRI provides a wealth of information to help you build .NET applications. The ESRI Resource Center for Geoprocessing (resources.esri.
com/geoprocessing) is your one-stop shop for searching for reference
materials, forum postings, and sample code. The Developer Resources
section will provide you with the ArcObjects API reference, the
geoprocessing tool reference, and the Geoprocessing Object Model
Diagram (OMD). Of course, the ArcGIS Engine Forums are always
a good place to search for help and sample code. Lastly, the .NET
Framework Developer Center on the Microsoft Developer Network
(MSDN) (msdn.microsoft.com/en-us/library/aa139615.aspx) is a great
place to find reference materials for anything related to general .NET
development.
Conclusion
There is no denying that the .NET platform is complex and daunting
when viewed by a beginning programmer. That said, I truly hope that
the samples provided here have shown that creating simple geoprocessing programs with .NET is within your reach. No matter the data
format used—from shapefiles to file geodatabases—and whether you
are working with ArcSDE or ArcGIS Server, the ESRI geoprocessor and .NET are a powerful and well-tested combination that can
automate both simple and incredibly complex processes. For more
information, contact
Chad Cooper
GIS Analyst
Southwestern Energy Company
chad_cooper@swn.com
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Hands On

CHOOSING A SCENIC BYWAY
USING SPATIAL CRITERIA
An exercise in planning with GIS
By Joseph Kerski, ESRI Education Manager

Editor’s note: This exercise assumes a working knowledge of ArcGIS Desktop and is
intended for intermediate GIS users, university or community college students, and
experienced secondary students. It uses ArcGIS Desktop to examine current byways and
select a new byway based on specific spatial criteria and ArcGIS Explorer to visualize
existing and planned byways.

What You Will Need
• ArcGIS Desktop 9.3
• ArcGIS Explorer
• Sample dataset downloaded
from ArcUser Online

One of the author’s favorite byways. This road hugs the south side of Haleakala Volcano on the island of Maui.
All of us have probably enjoyed traveling on
a scenic byway at one time in our lives. What
makes this route especially memorable? Have
you ever thought about the qualities that are
used in determining the criteria to designate a
state or national scenic byway?
Because these criteria are inherently geographic in nature, planning a scenic byway
is routinely done with the help of GIS. These
plans represent an interesting mix of objective
and subjective considerations. Consequently,
choosing scenic byways can make an excellent instructional activity using GIS because
it combines inquiry, technology, and multiple
disciplines in a decision-making environment.
A new lesson in the ArcLessons library,
Planning a Scenic Byway in Colorado, places
you in the role of the State Scenic Byways
program coordinator (an actual job position).
As the coordinator, you will consider the
criteria used by the National Scenic Byways
www.esri.com

Nominations Guide. “Scenic” is only one of
six criteria used by the guide; others consider natural, historic, cultural, archaeological,
and recreational qualities. You must choose
between four roadways. To do this, you will
use a variety of data, including traffic patterns, terrain, rivers, and population centers
along with a weighting system, to choose the
roadway that best meets all the criteria. You
will consider federal land and terrain; using
ArcGIS Desktop and ArcGIS Explorer to view
the area in 2D and 3D will help you make your
decision. GIS skills developed in this lesson
include spatial and attribute querying, weighting, symbolizing, layouts, and the use of GIS
to make an informed decision.
In late 2009, the State of Colorado posted
a job opening for a State Scenic Byways program coordinator at the Colorado Department
of Transportation (CDOT) headquarters in
Denver. Here is the position description:

This position serves as the statewide Staff Authority on the scenic and historic byways program. It directs the program by formulating
policy for approval by the Governor’s Scenic
and Historic Byways Commission; serves as a
resource to local agencies, communities, and
byway organizations statewide; develops and
implements planning and marketing strategies
for the byway program; writes grant proposals
for public and private funds; administers and
supervises federal grant contracts; and interprets federal and state requirements. This position exists to work with CDOT staff; FHWA;
and resource agencies such as the Colorado
Department of Tourism, Bureau of Land Management, Colorado Historical Society, and
others, to implement strategies for directing
federal funding to Colorado.

Continued on page 42
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After reading this description, what do you
think would be the most challenging part of the
job, and why? Let’s say you decide to apply for
this job position, and based on your experience
with GIS, CDOT decides to offer you the job.
Your first task on the job is to learn all you can
about the existing state scenic byways. You do
this by examining a Colorado scenic map supplied by MilebyMile.com (www.milebymile.
com/maps/Colorado_road_map.pdf).
1. Go to the location where you downloaded
and unzipped the data and lesson from the
sample dataset archive.
2. Start ArcMap and open the scenic_byways_
colorado.mxd map document. What do you
notice about the pattern of scenic byways in
Colorado? What types of federal lands seem to
have the most scenic byways? Why?
3. Open up the attribute table of the scenic byways map layer and sort on Length. The values in the Length field are in meters. What is
the total length of scenic byways in Colorado?
Use the Statistics tool and give your answer in
kilometers.
4. Describe the location of the five longest
scenic byways in Colorado listing the towns
along the route. Give the length of each byway
in kilometers.
 How many of the five longest scenic byways in Colorado are on the Great Plains,
Description

or in the mountains?
 How many are along interstate, U.S., or
state highways?
 Why do you think these differences exist?
 How many scenic byways are in urban
centers, and how many cross the Continental Divide?
5. Choose three scenic byway segments in
the attribute table. Find these three segments,
or ones nearby, in the highways attribute table.
Examine the Average Annual Daily Traffic
(AADT), which is the average number of vehicles traveling on these roads each day.
 What is the AADT of your three chosen
segments? Sort on AADT and choose the
three most-traveled segments of highway
in Colorado.
 What is the AADT of these segments?
Zoom to each.
 Do the locations of these well-traveled
roads make sense?
 What is the AADT on the least-trafficked
road segment in Colorado, and where is it?
6. Symbolize the highway segments based
on the AADT field values. Use thicker lines
for more heavily traveled roads. Describe
the pattern of highway use in Colorado. Interstate highways are the most major roadways, followed by U.S. highways, then state
highways; these designations are in the field

Location

Towns Connected

Length (km)

1
2
3
4
5
Table 1: Information on the five longest byways
Type of Highway

Average AADT

Interstate
U.S.
State
Table 2: Average Annual Daily Traffic (AADT) for three selected segments
Byway No.

Scenic

Natural

Historic

Cultural

ROUTESIGN. Which type of highway experiences the most traffic in Colorado, and why?
7. Summarize AADT by ROUTESIGN and
indicate the average AADT on each type in
Table 2.
8. On the Colorado Scenic Byways site (www.
coloradobyways.org/Main.cfm), choose your
two favorite byways. Describe where they are
located, and explain why they are your favorites. Save your map document in an appropriate location.
Proposing a New Scenic Byway
This year, the state and citizens of Colorado
want you to propose one additional road as a
scenic byway. Four road segments have been
submitted for your consideration. To help you
make your decision, you first examine the
National Scenic Byways Nominations Guide,
which has been included in the sample dataset
you downloaded from ArcUser Online. This
guide lists six intrinsic qualities as essential
components used in designating a highway as
a byway: scenic, natural, historic, cultural, archaeological, and recreational. For the purposes of the National Scenic Byways Program,
these qualities are defined as shown in the
sidebar entitled “Scenic Byways Qualities.”
Weighing Qualities
Which of these six qualities seems most important to you? Least? Why?
1. Examine your scenic_byways_proposed
map layer. The six qualities have been assessed
and applied to four different road segments in
Colorado that are contained in this layer: Proposed Byway 1 is in west central Colorado,
along State Highway 139 between Loma and
Rangely. Proposed Byway 2 is in north central
Colorado, along State Highway 9, U.S. Highway 40, and State Highways 14 and 125 from
Silverthorne to Kremmling, to Walden, and
north to the Wyoming border. Proposed Byway 3 is in east central Colorado along U.S.
Highway 36 from Byers east to the Kansas
border. Proposed Byway 4 is in southeast Colorado along U.S. Highway 160 from Trinidad
east to the Kansas border.
Archaeological

Recreational

Byway 1
Byway 2
Byway 3
Byway 4
Table 3: Quality assessments for proposed byways
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SCENIC BYWAYS QUALITIES

Scenic—The heightened visual experience derived from the view of
natural and man-made elements of the visual environment of the scenic
byway corridor. All elements of the landscape contribute to the quality
of the corridor’s visual environment.
Natural—Applies to those features in the visual environment that are
in a relatively undisturbed state. These features may include geologic
formations, fossils, landform, water bodies, vegetation, and wildlife and
are relatively undisturbed by humans.
Historic—Reflects the historic actions of people and may include buildings, settlement patterns, and other examples of human activity, and
possess integrity of location, design, setting, material, workmanship,
feeling, and association.

Cultural—Cultural features provide evidence of the customs or traditions of a distinct group of people including crafts, music, dance, rituals,
festivals, speech, food, special events, and architecture and could highlight one or more significant communities and/or ethnic traditions.
Archaeological—Involves physical evidence of historic or prehistoric human life or activity that can be inventoried and interpreted. The ruins,
artifacts, structural remains, and other physical evidence have scientific
significance, educate the viewer, and evoke in the viewer an appreciation for the past.
Recreational—Involves outdoor recreational activities in association with
and dependent on the natural and cultural elements of the corridor’s
landscape. They include skiing, rafting, boating, fishing, and hiking. Driving the road may qualify as a pleasurable recreational experience.

The ArcMap document in the sample dataset contains layers showing federal lands, political boundaries, cities, topography,
and existing and proposed scenic byways.
Continued on page 44
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2. Fill in Table 3 to indicate how the six qualities were assessed for each proposed byway.
These quality assessment values are based
on a 1–10 scale with 10 reflecting the highest
quality so the byway with the highest score is
the one you will select. For example, a byway
with ratings of 7, 4, 3, 5, 9, and 1 would have a
final score of 29. If you chose the byway based
on the highest total score (with all qualities
given equal weight), which byway would be
chosen?
3. Conduct some research on these four
routes. For example, Byway 4 traverses the
Comanche National Grassland. This area covers over 435,000 acres of grassland that has a
rich history. It has been home to dinosaurs, the
Comanche Indian Tribe, cattle ranchers, and
the U.S. Forest Service and encompasses the
Cimarron Cutoff of the Santa Fe Trail and natural wonders including more than 257 species
of birds, such as Say’s phoebes, rock wrens,

Calculate the new field using the weighting
formula. Select all fields and operators
using the mouse rather than typing
in the formula box, or cut and paste
the expression that has been saved as
bywaysfinalscore.cal in the geodatabase.
To calculate a final score, use this formula:
(Scenic * 1.5) + Natural + (Historic * 3) +
(Cultural * 1.5) + (Archaeological * 0.5) +
(Recreational * 1.0)

In the scenic byways attribute table, add a
field named FinalScore and set its type to
Float. Also set Allow NULL Values to Yes.
western meadowlarks, mourning doves, and
redheaded woodpeckers. At Picketwire Canyonlands, more than 1,300 dinosaur tracks can
be viewed. Prehistoric rock art, early homesteaders’ rock huts, and limestone markers can
also be seen. Write a paragraph about each of
the four proposed byway routes, including as
many of the six byway qualities as you can in
each paragraph.
Based on your research, you feel that the
byways should not be equally weighted but be
weighted as shown in Table 4.

4. Open the attribute table for the scenic_
byways_proposed layer and add a field. Name
it FinalScore, set its type to Float, and set
Allow NULL Values to Yes. Why should the
FinalScore field be a floating point (i.e., with
decimals) type rather than an integer type?
5. Go to Options > Clear Selection, then
right-click the new FinalScore field > Field
Calculator. Calculate the new field using the
weighting formula. Select all fields and operators using the mouse rather than typing
Quality

Factor

Scenic

1.5

Historic

3.0

Cultural

1.5

Archaeological

0.5

Recreational

1.0

Table 4: Weighting factors for qualities
Bypass

in the formula box. Alternatively, click the
Load button on the Field Calculator and load
bywaysfinalscore.cal, the expression that has
been saved in the geodatabase. Click OK to
populate the FinalScore field with calculated
values.
6. Which proposed byway received the
highest final score, and where is it located?
Symbolize the four byways using graduated
symbology. Use the values in the FinalScore
field to determine the thickness of the lines.
What does this new map help you to do?
Besides the six quality criteria, consider the
amount of federal lands that the roads cross.
Because the federal lands were set aside as national forests, grasslands, and national parks,
the more federal lands that a proposed bypass
crosses, the better candidate it will make.
7. To find out the amount of federal lands
these roads cross, intersect the proposed bypasses with federal lands and save the output
feature class in the geodatabase. Symbolize
the proposed bypasses that intersect federal
lands using a shade of blue. Which of the four
proposed bypasses intersect federal lands?
8. To determine which bypasses intersect the
most federal lands, access your attribute table
for the new intersect layer. Select the segments
with a final score of 41 (Bypass 2) using Select By Attribute or by highlighting them
with the mouse in the table. Right-click the
shape_length field and choose Statistics. Note
the length, in meters, of the roadway. Do the
same thing for each segment with a final score
of 43.5 (Bypass 4) and note its length (also in
meters). Fill out the table below and convert
length to kilometers. Which bypass would you
select based on the criteria of the length of
roadway on federal lands?
9. Next, weight the less-trafficked bypasses
more favorably, because you consider a large
number of vehicles antithetical to the whole
notion of a scenic byway. As you did earlier, select the four different byways by their
FINALSCORE, one by one, summarizing on
AADT, entering the mean AADT for each bypass in Table 6.
Based on these numbers and your preference, which bypass should be selected? Could

Length, in kilometers, of bypass that intersects federal lands

Bypass 2
Bypass 4
Table 5: Bypasses that intersect the most federal lands
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a busier roadway be considered more worthy
of being designated a scenic byway? How?
Following are a few analyses:
River Analysis
Turn on the rivers layer. Which of the four
proposed bypasses seems to cross or follow
the most rivers? What are the differences between rivers on eastern plains versus rivers
in the mountains? How do rivers impact the
scenery, and does considering rivers change
the bypass that you most want to select? Why
or why not?
Urban Areas Analysis
Turn on the cities layer. Which of the four
proposed bypasses seems to be nearest cities?
Symbolize the cities as graduated symbols
based on the attribute Pop100. Which of the
four proposed bypasses is nearest major cities? Does considering city locations and sizes
change the bypass that you most want to select? Why or why not?
Terrain Analysis
Turn on the shaded relief layer. Which of the
four bypasses traverses the most varied terrain
and the flattest terrain? Does a consideration of
the relief of the landscape as shown on the shaded relief layer change your judgment on which
bypass should be selected? Why or why not?

Conclusion
In this exercise, you used spatial analysis techniques and data from a variety of sources to
consider several criteria, weight them, and
make a better decision. For additional exercises and instructional materials, visit www.
esri.com/arclessons.

Bypass

This lesson incorporates querying
spatial and attribute data, weighting
factors, and symbolizing the results of
analysis so a more informed decision
can be made.

Mean AADT

Bypass 1
Bypass 2
Bypass 3
Bypass 4
Table 6: Mean Average Annual Daily Traffic (AADT) for bypasses

Add the
feature classes
to ArcGIS
Explorer to
see if viewing
the data in
3D changes
your choice of
byway.

Looking at Data in 2D and 3D
1. Start ArcGIS Explorer and add the feature
classes for existing and proposed scenic bypasses from your geodatabase. Does the 3D
capability of ArcGIS Explorer change your
answer to the previous questions in terms of
which bypass is on the steepest or flattest terrain? Do you consider steep or flat terrain to be
more scenic? Does the 3D perspective change
your mind in terms of the bypass you most favor? Why or why not?
2. In ArcMap, create a layout that contains a
title, north arrow, name, scale bar, legend, the
selected bypass in a different color than the
other byways, and any other information that
you feel is necessary. How did the weights that
you assigned to each of the six quality criteria
affect the final score?
3. Rerun the calculations with your own
weights. How did you weight the criteria, and
why?
4. Give a presentation about what you have
learned about scenic byways, how byways are
selected, and how the spatial perspective and
GIS enhanced your decision-making process.
www.esri.com										
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What You Will Need
• ArcGIS Desktop 9.3
(ArcView, ArcEditor,
or ArcInfo)
• Sample dataset
downloaded from
ArcUser Online

Address geocoding is an essential public
safety skill. However, officers need to understand the benefits, limitations, and complexities of systematic address locators. To quickly
and accurately map incident locations, a
Public Safety Access Point (PSAP) relies on
computer-aided dispatch (CAD) software and
georeferencing datasets to match the caller’s
address to a point on the map. At the dispatch
center, a trained operator must capture, interpret, record, and map as much incident information as possible.
After determining the incident’s location,
the operator identifies the needed and available
resources and passes as much information as
possible to responding units. These tasks must
be accomplished as quickly as possible—typically 60 seconds or less. Once mapped, the
CAD system matches the closest available
emergency resources with the call type and
sends out automated tones, coupled with digital information and voice instructions. Consis46 ArcUser Spring 2010

Quickly and accurately map emergency incidents
with a composite address locator
By Mike Price, Entrada, San Juan, Inc.

tent, complete, and current addressing datasets
are essential to this process.
This exercise shows how to produce addressing datasets by creating geocoding services or address locators for three datasets
that will place a location on a map with a high
degree of accuracy. Rather than geocoding a
single incident, this exercise processes several thousand incident points captured during
a single year in a major metropolitan area.
Standardizing addresses and using a progressive composite address locator will achieve an
extremely high success rate on the very first
pass. This exercise applies the same sequential
logic that is used by response centers around
the world.
The data for this exercise was created for
a textbook and tutorial series on performing
emergency services mapping. It is based on
data from actual jurisdictions and represents
field conditions but has been modified to protect sensitive information.
The exercise is organized into five tasks.
Task 1: Understanding Addressing Data
Obtain and analyze geocoding reference data.
Review incident data format(s).
Task 2: Creating Individual Address
Locators
Design and build stand-alone address locators
for each reference dataset.

Task 3: Building a Composite Address
Locator
Combine all address locators in hierarchical
order in a composite address locator.
Task 4: Geocoding Incidents
In ArcMap, geocode nearly 7,000 emergency
incidents, updating unmatched addresses and
resolving ties.
Task 5: Adding Detailed Information
about Incidents
Join incident date and type information to all
geocoded points to display fires and explosions, Hazmat incidents, emergency medical
services (EMS) responses, and service calls.
Getting Started
To get started, go to the ArcUser Online and
download Lakewood.zip. Store this file near
a root directory and extract the data, respecting directory structure. Start ArcMap, navigate
to the new Lakewood folder, and open Lakewood1. Right-click in an open toolbar area and
select the Geocoding toolbar. Move it next to
the other open toolbars and inspect its buttons.
The Address Locator Manager and Geocode
Addresses buttons are active. Two other tools,
Location Inspector and Review/Rematch Addresses, are inactive.

www.esri.com

Hands On

The exercise
data is based
on data
from actual
jurisdictions
and represents
field
conditions
but has been
modified
to protect
sensitive
information.

Task 1: Understanding Addressing Data
A typical PSAP will use several address datasets to place an incident on a map. A geocoding sequence starts with the most reliable, accurate, and current dataset available to identify
a single point location on a map. To increase
the success rate of the geocoding process, the
service will standardize incoming addresses to
match the reference data schema. Place-name
alias tables also increase geocoding reliability.
1. Open the attribute table for GC1 Parcel
Centroids and inspect its fields. Study the
SITE_FULL field and sort it. Notice that each
address includes one standardized string, possibly including an address numeric; a direction prefix, a street name, a street type, and a
direction suffix. These address points provide
a certain address match against standardized
input data with a high degree of reliability.
2. Open the attribute table for GC2 City
Streets and inspect its fields. This dataset, developed and maintained by the Lakewood Public Works Department, is current and complete.
This polyline dataset separates addressing into
left and right and to and from numerics, and
includes separate fields for name direction and
type. GC2 City Streets is the second geocoding data source. It supports a U.S. Streets Lowww.esri.com

Create a Single Field Address Locator that references the GC1_Parcel shapefile.
Continued on page 48
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Name:

Description:

Reference data:

Store relative Fields
path names

The field
containing:

Is recognized if
it is named:

Place Name
Alias Table

1_Parcel_Single_Field Single Field

\GC1_Parcel.shp

Checked

Key Field –
SITE_FULL

KeyField

Address2

<None>

2_City_US_Streets

US Streets

\GC2_City_Street.shp

Checked

See Table 2

Street

Address2

<None>

3_TIGER_US_Street

US Streets

\GC3_TIGER_
Street.shp

Checked

See Table 2

Street

Address2

<None>

Table 1: Parameters for creating individual address locators
cator. Unfortunately, CAD data often does not
include sufficient information to apply a U.S.
Streets with Zone Locator. Typically this data
lacks municipality or ZIP Code information.
Each agency must decide how to clip streets to
include unique names or process addresses in
different communities that share similar street
names.
3. Next, open the attribute table for the GC3
TIGER Street shapefile and inspect its fields.
This dataset is adapted from 2009 Census
TIGER street data, now in development by
the U.S. Census Bureau. It includes a schema
similar to the Lakewood Public Works data.
Notice that field names and placement are different. This is the third addressing dataset, and
it captures many road intersection addresses
and the locations of incidents that might occur
outside the extent of the Public Works dataset.
The TIGER 2010 data, not yet released, will
be different from TIGER 2000 data.
4. Now click the Add Data button, navigate
to \Lakewood\DBFFiles and locate Inc_2008_
Address, and load this table containing incident data. Open this table and inspect it. This
dataset contains nearly 7,000 incident records
and has only a few fields. It has an index field
(INDEX), an incident number field stored as
an alpha string (INC_NO), and a standardized
address field named (ADDRESS2). Notice
that there is no field in this dataset to identify a
geocoding zone.
5. Sort ADDRESS2 and notice it contains
both numeric and street intersection addresses.
These addresses were generated and posted using CAD software, then edited by the local jurisdiction to correct inconsistencies. This data
is clean and contains only incident addresses.
Other information will be joined to these geocoded points later using the INC_NO field.
To review: In this task, the three reference datasets in the map document were reviewed, and one file containing incident data
was added to the map document.
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The second
geocoding data
source, GC2 City
Streets, supports a
U.S. Streets Locator.
It is maintained by
the Lakewood Public
Works Department
and is current
and complete. It will
be used to build the
2_City_US_Streets
address locator.

The data source for the
third address locator,
the GC3 TIGER
Street shapefile, was
adapted from 2009
Census TIGER street
data, now in
development
by the U.S.
Census
Bureau.
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Spelling
sensitivity

Minimum
candidate score

Minimum
match score

Connectors

Side offset:

End offset:

Match if candidates
tie

Output Fields

100

100

100

<Blank>

<Blank>

<Blank>

Unchecked!

Optional

80

60

80

&I@

20 Feet

3

Checked

Optional

80

60

80

&I@

20 Feet

3

Checked

Optional

Task 2: Creating Individual
Address Locators
Address locators will be created for each reference dataset in this task.
1. Save the ArcMap document, close ArcMap,
and start ArcCatalog. Navigate to \Lakewood\
SHPFiles\StatePlane and preview the tables
and geography for the shapefiles. The file
name for each reference file begins with the
letters GC and a numeric code that indicates
that file’s geocoding sequence.
2. In the ArcCatalog tree, right-click the
\Lakewood\SHPFiles\StatePlane folder and
select New > Address Locator. Specify Single
Field as the Address Locator Style and click
OK.
3. In the New Single Field Address Locator
dialog box, enter 1_Parcel_Single_Field as the
Address Locator name. On the Primary table
tab, set Reference data to \GC1_Parcel.shp
and set SITE_FULL as the Key Field. In the
Input Address Fields area, delete Name from
the field under is Recognized if it is named and
add Address2. Set all scores and sensitivities to
100.
4. Under Output options, uncheck the box
next to Match if candidates tie. It is essential to uncheck this box because all ties (based
on duplicate addresses) will be bumped to the
City Streets locator. Click OK to build the

1_Parcel_Single_Field locator.
5. Build the 2_City_US_Streets geocoding service by right-clicking the \Lakewood\
SHPFiles\StatePlane folder and creating a
second address locator. Use Tables 1 and 2
as guides when creating this locator. Name
this address locator 2_City_US_Streets. Set
\GC2_City_Street.shp as the reference set,
and define reference fields using the same
parameters as 1_Parcel_Single_Field locator. This time, using the information in Table
1, specify fields for numerics, direction, and
type. Although many addresses will automatically match, don’t forget to make sure STYPE
is chosen for the Street Type field. If a required
field is accidentally omitted when creating a
locator, delete the locator and rebuild it. Set
only Address2 as the recognized field and set
spelling and scores to 80, 60, and 80. Accept
the Connectors defaults and leave other choices unchanged. Click OK to build this locator.
6. Next, build the 3_TIGER_US_Street
geocoding service using parameters in Tables 1
and 2. This locator is similar to the 2_City_
US_Streets locator. Because the new TIGER
codes are not consistent with earlier systems,
the field names will not assign automatically,
so carefully assign fields as shown in Table 2.

Address
Locator

2_City_US
Streets

3_TIGER_US
Streets

House From
Left:

FRADDL

LFROMADD

House From
Right:

TOADDL

LTOADD

House To Left:

FRADDR

RFROMADD

House To Right:

TOADDR

RTOADD

Prefix Direction:

PREFIX

FEDIRP

Prefix Type:

<None>

<None>

Street Name:

NAME

FENAME

Street Type:

STYPE

FETYPE

Suffix Direction:

SUFFIX

FEDIRS

Table 2: Fields for U.S. Streets Address
Locators
Task 3: Building a Composite
Address Locator
The three individual address locators
just created are now linked together in
a composite address locator. A composite locator links two or more other address
locators together in a hierarchical order
Continued on page 50

Name

Address Locator

Selection
Criteria:

Input Mappings

The field
containing:

Is recognized
if it is named:

Output
Fields

Output Spatial
Reference

Store relative
path names

Checked

1_Parcel_Single_
Field

Blank

KeyField
Address

Address

Address2

Optional

NAD_1983_StatePlane_
Washington_North_FIPS_
4601_Feet

Checked

Checked

2_City_US_Streets

Blank

Street or
Intersection
Address

Address

Address2

Optional

NAD_1983_StatePlane_
Washington_North_FIPS_
4601_Feet

Checked

Checked

3_TIGER_US_
Street

Blank

Street or
Intersection
Address

Address

Address2

Optional

NAD_1983_StatePlane_
Washington_North_FIPS_
4601_Feet

Checked

Table 3: Parameters for composite address locator
www.esri.com
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and passes unmatched addresses from each
locator to the next. This composite address locator will geocode using Parcel Centroids first,
then City Streets, and finally TIGER Streets.
1. Right-click the \Lakewood\SHPFiles\
StatePlane folder and specify Composite Address Locator.
2. Using Table 3, name this locator
Composite_Parcel_ Street_TIGER and add
participating locators in order: 1_, 2_, and 3_.
These numeric name prefixes will be useful
soon.
3. Once all three are loaded, perform the next
step. It is a performance tip. On the right side
of the New Composite Address Locator wizard, find the Input Address Fields area. Next
to The field containing window, click the Add
button and specify Address as the primary field.
Set its recognized name to only Address2. By
specifying only Address2, the composite address locator will target only standardized
data and ignore other Address fields. Typically
reference datasets can also contain a primitive
Address field.
4. Keep all Participating Address
Locators checked; select each one
and individually set its Input Mappings field to Address. Use any
individual address locator to calculate the output spatial reference.
After setting the spatial reference
and all three Input Mappings, the
OK button should become active.
If it does not, review the setting.
Click OK to build the composite
address locator. Now it is time
to geocode all 6,976 incidents.
Close ArcCatalog and reopen the
Lakewood map document in ArcMap.
Task 4: Geocoding Incidents
Now, after setting some parameters for the composite address
locator, it will automatically geocode all the incidents.
1. In ArcMap, load the Geocoding toolbar, if necessary,
and click the Address Locator Manager button. Navi-
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Use the three individual address locators to create a composite address locator.

Keep all Participating Address Locators checked and select each one and individually set its
Input Mappings field to ADDRESS2.
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The composite address locator should
generate 20 ties and 12 unmatched addresses.
gate to \Lakewood\SHPFiles\StatePlane
and load only Composite_Parcel_Street_
TIGER. Close the Locator Manager window.
2. Open the TOC Source tab, right-click the
Inc_2008_Address table, and select Geocode
Addresses.
3. Set the output file location and name to
\Lakewood\SHPFiles\StatePlane\Inc_2008_
GC1. Using a numeric counter in the file
name will make it easier to rerun the model
or test it with differing parameters. Click the
Geocoding Options button to verify that all
three individual locators participate in the
composite address locator. Update or adjust
properties, such as spelling sensitivities and
threshold scores, at the same time if necessary.
Click OK to continue and watch the geocoding
process.
4. If the three address locators were built according to the specifications given, they should
generate a high percentage of matches. Only
about 20 ties and 12 unmatched addresses
should be left from the set of 6,976 incidents.
5. The sample dataset includes a Microsoft
Excel spreadsheet containing suggested fixes
for known addressing errors. Navigate to
\Lakewood\Utility and load the Database
worksheet, Fixes1.xls. Review its contents.
In the real world, records management at a
fire station is never perfect, and this spreadsheet contains fixes for several nongeocoded
records.
6. To update these unmatched or tied records, click the Rematch button. Let’s repair
unmatched addresses. Under Interactive Rematch, look at the Show results area and select Unmatched Addresses. In the results window, locate an improperly geocoded address
and find its corresponding entry in the Fixes1
table. Copy the ADDRESS2_F string into the
text box next to Address on the left side of the
Interactive Rematch dialog box. Click the address in the Candidates list and select the record with the highest percentage (which will

Click the Rematch button and under Interactive Rematch, select Unmatched Addresses.

Use the Fixes1 table to fi x unmatched addresses by copying the ADDRESS2_F string into
the text box next to Address on the left side of the Interactive Rematch dialog box.
likely be the one with the highest order, e.g.,
1_, 2_, or 3_) and click Match. The score will
change from U to M, and the Loc_name field
now lists reference data, providing the best fit.
Continue down the list, making repairs, selecting the best reference data and building matches. When finished, all records should match.
7. Review tied records next. In Show results,
select Matched Addresses with Candidates
Tied. Locate the ADDRESS2 window and
sort its contents so identical tied addresses are

grouped. Ties often occur in clusters, so fixing
one will often fix others.
8. Click one of the candidates in the window.
The selected record is displayed as a larger
yellow dot on the map. Below the Candidates
window, click the Zoom to Candidates button.
If you could access the actual incident records,
you could select the appropriate point. However, that is not the case in this exercise, so select the westernmost or northernmost point (as
long as these points are in close proximity—
Continued on page 52
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Continued from page 51

say, 1,000 feet or less). Click the Pick Address
from Map button and use the crosshair tool to
choose the best candidate, then click Match.
Also check the Fixes1 spreadsheet to see if any
ties show up there.
After matching the last tied records, all
tied records should show a 100 percent score.
While matching ties, look for the reasons they
occurred. Some are readily fixed by editing
street address ranges, which will require that
you rebuild the affected address locators before continuing. Other errors, such as those
caused by looped streets and offset intersections, are hard to avoid.
Finally, consider matched addresses that
score less than 100. Show results for matched
addresses and sort the Score field in ascending
order. Only a few records will have scores less
than 100. See if you can boost those scores to
100 by using observations, intuition, and the
Fixes1 spreadsheet. After fixing all records,
close the Interactive Rematch dialog box and
save the map document.
Task 5: Adding Detailed Information
about Incidents
The input data contains only incident numbers
and addresses. With all these points properly
placed on a map, joining or relating data from
other tables will add more information on the
incidents such as date and type of incident.
The last step will symbolize incidents using
a graduated color scheme that identifies incidents by type.
1. Navigate to \Lakewood\DBFFiles and add
Inc_2008_Date_Type.dbf to the map document. Open Inc_2008_Date_Type and compare
it to the attribute table for Geocoding Results:
Inc_2008_GC1. Note that these tables share
a common field, INC_NO, so there may be a
one-to-one relationship between the tables.
2. Right-click Geocoding Results: Inc_
2008_GC1 and choose Join. Create this join
to Inc_2008_Date_Type.dbf using INC_NO
as the common field. Inspect the results and
verify that all records have joined.
3. The next step symbolizes incident points
using a graduated color legend that corresponds to the National Fire Incident Reporting
System (NFIRS). Open the Layer Properties
dialog box for the incident layer (Geocoding Results: Inc_2008_GC1) and click the
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Join the table Inc_2008_Date_Type to
Geocoding Results: Inc_2008_
GC1 to symbolize the incidents. Load the
ArcView 3.x legend to use the
NFIRS color scheme.
properties to learn more about NFIRS incident types. Incidents are coded thus: 100 series points are fire related; 200 series points
are explosions or ruptures; 300 series points
are rescues and EMS calls; 40 series points
are hazardous conditions; and all points over
499 are service calls, false alarms, and special
calls.

Symbology tab. Click the Import button and
choose ArcView 3 (*.avl) file and navigate to
the \Lakewood\Utility folder. Select nfirs5_3.
avl and set the Value field to NFIRS_TYPE.
Click OK several times to apply the legend.
4. Save the finished project. Once the color
scheme is applied, check the symbology
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Once the incidents are symbolized, check the symbology properties to learn more about the
incidents.
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Boosting Geoprocessing Productivity
Why and how to organize geoprocessing projects
Project Setup Checklist
 Create a project folder. Give it a descriptive
name and date.
 Create a project toolbox. Give it a descriptive name.
 Create a System Tools toolset inside the
project toolbox.
 Populate the System Tools toolset with the
needed system tools.
 Create a Project Tools toolset inside the
project toolbox for custom tools.
 Create the Project Folder Structure model in
the ProjectTools toolset.
 Set the Folder Location in the Project Folder
Structure model to the project folder and run
the model to create folders.
 Set the Current Workspace to the indata
folder and Scratch Workspace to the outdata
folder.

By Barbara Bicking, ESRI Product Engineer, Geoprocessing Team
Editor’s note: ModelBuilder and the geoprocessing tools in ArcToolbox are designed
to make users more productive. The author of this article introduces a simple workflow
that helps make geoprocessing work easier and faster—even fun—and will make it
more easily shared. Consistently using her methodology for setting up and documenting projects will eliminate questions such as
Where was that tool again?
Where did I stick that model?
How did I do that?
This exercise steps the reader through a fictional project. The workflow described is
based on using ArcGIS 9.3.1 ArcCatalog with ArcToolbox, but the process is the same
in ArcMap. It consists of five tasks.
1. Customize the ArcToolbox window.
2. Create a project toolbox with the system and custom tools needed for the
project.
3. Create a folder structure for holding output from processes, documentation,
and other project materials automatically using a model.
4. Set the project environment parameters.
5. Document the project.

 Export all models to a graphic and save the
graphic in the docs&pics folder inside your
project folder.

Getting Started
The fictional project in this exercise is based
on creating buffers around selected wells in
a study area.

 Export all models to a Python script in the
scripts folder inside your project folder.

1. The first step is creating a project folder.
Use Windows to create a folder, and name
it BufferSelectedWellsInStudyArea. Use
descriptive names for project folders,
toolboxes, models, and script tools and
use the same name for everything that
pertains to a project. Documenting projects by using descriptive names is critical
to productivity. Adding the date to file
names(e.g.,BufferSelectedWellsInStudyArea_12Oct09) is also a good practice.

 Create a model report for all models and
save the graphic in the docs&pics folder
inside your project folder.

Select system tools and place them in the
SystemTools toolset.

2. Start ArcCatalog and make the
ArcToolbox window visible. Before
changing the ArcToolbox window
settings, save the default setting to a file.
Continued on page 54
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All the system tools that should be collected in
the SystemTools toolset are shown.

Task 1: Customize the ArcToolbox Window
Now customize the ArcToolbox window. This
project uses only a few toolboxes. Removing
unneeded toolboxes will make it easier to find
the ones that will be used. Removing toolboxes
from the ArcToolbox window does not delete
them from the program. All tools in toolboxes
covered by the license level remain available
and can be loaded back into ArcToolbox. To
add a toolbox back into the ArcToolbox window, just right-click in the ArcToolbox window
and select Add Toolbox. Navigate to the Toolboxes folder (typically C:\Program Files\arcgis\
ArcToolbox\) and select the desired toolbox.

Task 2: Create a Project Toolbox
A project toolbox will be created in the
BufferSelectedWellsInStudyArea project folder
so geoprocessing work can be performed without having the ArcToolbox window open.

1. Start removing the toolboxes not needed for
this project by right-clicking 3D Analyst
Tools and selecting Remove. Toolboxes are
removed one by one, but once the process is
done, it’s done.

2. Right-click in the ArcToolbox window,
choose New Toolbox, and name the new
toolbox BufferSelectedWellsInStudyArea.

2. Repeat this for all toolboxes except Analysis
Tools, Conversion Tools, and Data Management Tools.
3. Save these settings by right-clicking in the
ArcToolbox window and choosing Save Setting > To File. Name the file BufferSelectedWellsInStudyArea and save it to the project
folder with the same name.

1. To change the default location of toolboxes
and models in ArcCatalog (or ArcMap), Select Tools > Options, click the Geoprocessing
tab, and navigate to the BufferSelectedWells
InStudyArea_12Octk09 folder, click Apply
and click OK. [To reinstate the default location for storing toolboxes, go to this dialog
box again and click the Reset button.]

3. The project uses two types of tools: System
tools that come with ArcGIS and Project
tools that will be created. Creating two toolsets will keep these types of tools separate.
Create the first toolset by selecting the BufferSelectedWellsInStudyArea toolbox, rightclicking it, and choosing New > Toolset.
Name the new toolset SystemTools. [Note:
Two toolsets may be generated—this is a
known issue. Simply go to ArcCatalog and
choose View > Refresh to remove the extra
toolset from the display.]

Drag the Create Folder tool onto the model.
Right-click the tool and choose Make Variable
> From Parameter > Folder Location.

Right-click in the ArcToolbox window and
choose Save Settings > To File to C:\ and
name the file defaultATBwindowSettings.
[Note: In ArcCatalog, it is necessary to save the
settings, whether default or custom, to preserve
them. In ArcMap, each new map document is
created with the default settings. Changes are
saved with the map document (.mxd). Settings
changed in ArcCatalog can be saved as an .xml
file. This file can be loaded into ArcMap where
the settings become part of the map document
or can be shared with others.]

Open the Model Properties dialog box, click the Iteration tab, select Get the iteration count from
this variable, and select Folder Name from the drop-down menu.
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4. Populate the SystemTools toolset by selecting it, right-clicking, and choosing Add >
Tool. In the Add Tool dialog box, expand
Analysis Tools, expand the Extract Toolset,
and check the Clip and Select tools. Still in
Analysis Tools, expand the Proximity toolset
and check the Buffer tool.

Double-click the Folder
Name node to open the
variable dialog box and
add four more rows by
clicking the Add Data
button. Click on each row
and enter the folder names:
indata, outdata, docs&pics,
scripts, and mxds.

5. Expand the Conversion Tools, expand the
Geodatabase toolset, and check the Feature
Class To Feature Class tool.
6. Expand Data Management Tools, expand
the Features toolset, and check the Add XY
Coordinates and Copy Features tools. Still in
Data Management Tools, expand the Fields
toolset and check the Add Field tool, then expand the General toolset and check the Copy,
Delete, and Rename tools. Expand the Table
toolset and check the Copy Rows tool. Finally, expand the Workspace toolset and check
the Create Folder tool.
7. Click OK. The tools will be added to the
SystemTools toolset.
8. Next create a second toolset and name it
ProjectTools. Although both toolsets were
created in the ArcToolbox window, they
are stored in the project toolbox, which
was created in the BufferSelectedWellsInStudyArea project folder. The ArcToolbox
window merely points to, rather than stores,
resources.
9. Close the ArcToolbox window.
Task 3: Create the Project Folder Structure
with a Model
The next task will be to build a model in the
project folder that will automatically generate
five folders (indata, outdata, doc&pics, scripts,
and mxds) that will keep the materials for the
project organized.
1. Create a new model in the ProjectTools toolset by right-clicking it and choosing New >
Model.
2. Access the Model Properties dialog box by
either using the Model menu and choosing Model Properties or by right-clicking
the model canvas and choosing Model
Properties.
3. In the Model Properties dialog box, name the
model projectFolderStructure. For the label,
enter “Project Folder Structure,” and for the
description, enter “Setting up project folder
structure”. Check the box next to “Store
relative path names so paths” will reflect the

toolbox’s location in the project folder.
4. Click the Environments tab. Expand General
Settings and check Current Workspace and
Scratch Workspace. Click the Values button.
Expand General Settings in the new dialog
box and set the Current Workspace location
to C:\ and the Scratch Workspace to C:\temp.
Click OK.
5. In the Model window, save the model. The
model name now appears in the ArcToolbox
window.
6. Now to build the model. Expand the SystemTools toolset. Drag and drop the Create Folder tool onto the model. Right-click
the tool and choose Make Variable > From
Parameter > Folder Location. Double-click
the Folder Location variable node to open
its dialog box. Set it to the BufferSelected
WellsInStudyArea_12Oct09 project folder.
Because the workspace is set to C:\, the path
will automatically be appended. Click OK.
The model nodes are now colored.
7. To create the five project folders (indata, outdata, docs&pics, scripts, and mxds) in BufferSelectedWellsInStudyArea_12Oct09
will
require exposing the Folder Name parameter. Right-click the Create Folder tool and
choose Make Variable > From Parameter >
Folder Name.
8. The Folder Name node appears on top of
BufferSelectedWellsInStudyArea_12Oct09
so use the Select tool to move it to its own
spot in the model. The Folder Name needs
to be set to series so it will create five folders with five names. Right-click the Folder
Name node and choose Properties. On the
General tab of the dialog box, select A series
of values and click OK. [Note that the Folder Name node in the model is now stacked,
which indicates that there is more than one
input.] Double-click the Folder Name node
to open the variable dialog box. Add four
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more rows by clicking the Add Data button
four times to create a total of five rows. Click
each row and enter the folder names: indata,
outdata, docs&pics, scripts, and mxds. Press
the Tab key to move from row to row. Click
OK when done.
9. From the Model menu, choose Model >
Validate Entire Model. The model elements
are colored, which seems to indicate it is
ready to run. However, some additional modifications are needed. Save the model.
10. Model iteration needs to be set so the model
will use the five values for the folders. Reopen the Model Properties dialog box and
click the Iteration tab. Select Get the iteration count from this variable. From the dropdown menu, select Folder Name. Click OK
and save the model.
11. To make it easy to identify what this model
does, label the Folder Name parameter by
selecting it, right-clicking, and choosing
Create label. The word Label appears on
the Folder Name node. Moving the label
off the node is a little tricky. Click in a
white area of the model to deselect everything, then click the word Label and drag it
away from the node. Right-click Label and
choose Display Properties. In the Name
field, type “Series of 5 folder names used
in model iteration to set up the project folder structure”. Create another label for the
entire model by clicking in the white space
of the ModelBuilder window and choosing
Create label, then type “Creating folders to
set up the project folder structure” in the
Name field.
12. Validate the model and save it. Click the
Run button. The model should create the five
folders for the project.

Continued on page 56
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Task 4: Set Project Environments
Now that the project folders have been created,
the Current Workspace and the Scratch Workspace environment variables can be set. This is
done at the application level (i.e., in ArcCatalog).
In ArcCatalog, choose Tools > Options. In the
Options dialog box, click the Geoprocessing
tab and click the Environments button. Expand
General Settings and set the Current Workspace
to the indata folder in the BufferSelectedWells
InStudyArea_12Okt09 project folder. Set the
Scratch Workspace to the outdata folder, also
in the project folder. If a project requires that
the output coordinate system is consistent or a
fixed extent, this is also where those parameters
are set.
Task 5: Document the Project
Documenting the project is both important and
easy. This process will also preserve the project. Everything needed to do this is built into
ModelBuilder.
1. First, export the model as a graphic by choosing Model > Export > To Graphic. Save it as
BufferSelectedWellsInStudyArea.jpg in the
docs&pics folder.

Add labels to identify the
purpose of the model.

2. Next, export the model as a Python script by
choosing Model > Export > To Script > Python and save it using the project name in the
scripts folder.
[Note that the script created from the model
does not contain the model iteration that was
set using the Folder Name series variable.
Setting iteration for the script requires just a
few changes in the exported script, and those
changes are shown in Listing 1.]

3. The last thing to do to document the project
is to create a model report. Choose Model >
Report and save it in the docs&pics folder.
Conclusion
The true beauty of this process is that it can be
reused with every project from now on. Simply
follow the steps outlined in the Project Checklist that accompanies this article for projects
that will be well organized, documented, and
reusable.

REVOLUTIONIZE

YOUR GIS

EXPERIENCE
Work directly on screen to create,
collaborate, and share. Wacom interactive
pen displays allow GIS professionals to work
faster and more comfortably.
For more information on how Wacom can
help you revolutionize your GIS workflow,
visit us at: www.wacom.com/GIS
or www.esri.com/wacom

“I can complete a typical georeferencing project 20% faster with
the Wacom pen and monitor, compared to the trackball method.”
—Jenny Smithyman, Ste. Michelle Wine Estates

“It is exactly what we needed to modernize our workflow.”
— Gavin McGhie, Marin Municipal Water District

“Nothing has streamlined my mapping workflow more than
being able to map directly on the surface of a Wacom interactive
pen display.”
— Kyle House, Nevada Bureau of Mines and Geology

© 2010 Wacom Technology Corporation. Wacom is a trademark of Wacom Company Ltd. All rights reserved. All other trademarks are property of their respective owners.
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# --------------------------------------------------------------------------# BufferSelectedWellsInStudyArea.py
# Created on: Thu Sep 03 2009 01:37:54
#

(generated by ArcGIS/ModelBuilder)

# Description:
# Setting up project folder structure
# ---------------------------------------------------------------------------

# Import system modules
import sys, string, os, arcgisscripting

# Create the Geoprocessor object
gp = arcgisscripting.create()

# Load required toolboxes...
gp.AddToolbox(“C:/workspace/EnvironmentsDemo/EnvironmentsDemo.tbx”)

# Set the Geoprocessing environment...
gp.scratchWorkspace = “C:\\Temp”
gp.workspace = “C:\\workspace”

# Local variables...
Output_Folder = “C:\\workspace\\EnvironmentsDemo\\indata”
EnvironmentsDemo = “C:\\workspace\\EnvironmentsDemo\\outdata”
Folder_Name_List = “indata;outdata;docs&pics;scripts;mxds

##using a tbx ALIAS, such as envDemo, makes the #gp.toolbox location superfluous
#gp.toolbox = “C:/workspace/EnvironmentsDemo?Environments

# Process: Create Folder...
for Folder_Name in Folder_Name_List.split(';'):
##it is a good practice to qualify a tool by its tbx ALIAS name
##as shown here by using envDemo.
gp.CreateFolder_envDemo(EnvironmentsDemo, Folder_Name)

Listing 1: Exported python script
www.esri.com										
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National Land Parcel Data: A Vision for the Future
By the Mapping Science Committee of the
National Research Council
As the authors of this report state in the opening pages, “Private
ownership of land is the foundation of financial, legal, and real estate
systems” in the United States. Parcel data is also needed for analyzing
the impact of natural disasters, transportation needs, and other issues.
Consequently the creation and maintenance of landownership records
is a vital concern for individuals and governments at all levels. This
report provides a systematic assessment of the current state of parcel
data in the United States and makes recommendations on coordinating
the work of local, state, federal, and private organizations in the
creation of nationwide parcel data. (Note: This book may be read
online at no charge by visiting the National Academy of Sciences Web
site.) National Academies Press, 2007, 172 pp., ISBN-10: 0-309-11030-0

Maps: Finding Our Place in the World
Regional and Urban GIS:
A Decision Support Approach
By Timothy L. Nyerges and Piotr
Jankowski
Regional and Urban GIS: A Decision
Support Approach combines the theory
and implementation of GIS for decision
support, specifically in the areas of land,
transportation, and water resources
management. The motivation for writing
this textbook came from the need to answer
questions about “the research, development,
and practice of sustainability” and use GIS
to help move from individual sustainable
projects to methods and practices that
institutionalize sustainability. The target
audience for this book includes both
professionals and students. It cites realworld case studies and information on the
use of multicriteria evaluation (MCE),
which extends basic GIS-based analysis
by increasing the interactivity of decision
analysis activities. The Guilford Press, 2009,
299 pp., ISBN:160623336X

gis
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Edited by James R. Akerman and Robert W. Karrow Jr.
Maps: Finding Our Place in the World was written as a companion
to the ambitious museum exhibit of the same name in Chicago,
Illinois, mounted between November 2007 and January 2008 by the
Field Museum and the Newberry Library. However, this book is far
more than a slick catalog. It provides the reader with a broad view of
the role of maps in civilization, organized by the reason these maps
were created. It contains chapters on wayfaring maps, cosmological
maps, maps of local geography, maps that tell the stories of American
history, maps that describe phenomena such as William Smith’s
revolutionary map of the geology of England and Wales, and maps of
the imaginary landscapes such as the landscape of the online game
World of Warcraft. The maps selected for each chapter and the essays
written to acccompany them are entertaining as well as informative.
University of Chicago Press, 2007, 336 pp., ISBN: 0226010759

A Geography of Time: The Temporal Misadventures
of a Social Psychologist
By Robert Levine
As time is becoming more tightly incorporated in GIS software
implementation, it is interesting to explore how geographic location
affects the perception of time. Human perception of time is also
becoming a more relevant topic today because so many spatiotemporal applications revolve around decision support. A Geography
of Time: The Temporal Misadventures of a Social Psychologist
examines different concepts of time, how time has been measured,
and how different cultural norms relating to the tempo and duration of
time affect social interaction and the quality of life. In the course of
his yearlong travel to 20 countries, author Robert V. Levine observed
many of these differences firsthand. In addition to anecdotal evidence,
Levine, a psychology professor at California State University, Fresno,
cites research he conducted with his students comparing the pace
of life in 31 countries based on average walking speed, the time
required to purchase stamps, and the accuracy of bank clocks as well
as the observations and studies of others. In the end, Levine hopes
this survey helps readers examine their own perspectives on time and
arrive at a middle time that balances event time of less time-driven
places with clock time that is a prominent feature of life in the United
States. Basic Books, 1998, 288 pp., ISBN: 0465026427
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Capturing the Digital Ocean Floor
How GIS is used for mapping the undersea landscape
Although oceans dominate the earth’s surface,
the undersea world is far from fully explored.
As Dawn J. Wright notes in the foreward to
Ocean Globe, “95 percent of the global ocean
floor remains either unmapped or mapped at a
resolution that pales in comparison to the topographic maps that we have of Mars, Venus,

and the dark side of the moon.” The researchers who contributed chapters to this new ESRI
Press book are working to improve our knowledge of the seafloor using GIS to manage,
model, and map data to create a truly digital
earth—one that includes the oceans that cover
70 percent of the earth’s surface.

ESRI Is Your Total
Solution Provider
Total solutions from ESRI can
provide technology you need at
prices you can afford. ESRI works
with leading hardware vendors to
provide bundled solutions that include
ArcGIS® Server, ArcGIS Desktop, ArcPad®,
and much more. For example, you can
purchase an ArcGIS Data Appliance or a server, workstation, notebook,
GPS Handheld, or Tablet PC bundled
with ArcGIS software. Custom
hardware-only configurations
are also available to existing

Copyright © 2009 ESRI. All rights reserved.

ESRI customers.

www.esri.com

For more information on promotional offers,
visit www.esri.com/hardware or call your
local ESRI office. Offers are updated frequently.

Contributors to this book come to seafloor
mapping from very different perspectives:
from researchers concerned with tsunami
modeling and forecasting to biologists studying sea turtles to scientists trying to determine
sites for sustainable aquaculture. Each chapter
describes a different aspect of marine research
that relies on seafloor mapping and uses GIS
to meet that need. An appendix by Albert E.
Theberge Jr. provides a brief history of seafloor
mapping.
The first chapter, “Bathymetry—the art
and science of seafloor modeling for modern applications,” coauthored by Timothy A.
Kearns and Joe Breman, describes modern
data capture techniques, methods of GIS data
representation, and applications of bathymetric data and is of special interest to the general
GIS practitioner as well as those specializing
in marine GIS.
Breman, also the editor of this volume,
served as the editor for Marine Geography
and a coauthor of Arc Marine: GIS for a
Blue Planet, both published by ESRI Press.
Breman is the founder of International Underwater Explorations in Maui, Hawaii. He is a
GIS architect with IT consulting firm Akimeka, LLC. He is also a professor of oceanography, guest lecturer for the National Oceanic
and Atmospheric Administration (NOAA)
Marine Sanctuary, and scuba diving instructor. Breman holds a master’s degree in marine
sciences from the University of Haifa, Israel,
and a bachelor’s degree from the University of
California, Santa Cruz.
Although the target audience for Ocean
Globe is college and graduate students, it’s accessible to anyone interested in gaining a better understanding of seafloor mapping. ESRI
Press, 2010, 294 pp.
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This conference is for all GIS

users regardless of experience or

industry. Attendees can access
more than 70 hours of learning

and training and discuss hot
topics such as geodesign, cloud

computing, Web 2.0, and green
government. They can connect with

like-minded peers, industry thought
leaders, and ESRI staff and

the ESRI User Conference

Attend

?

Why

business partners.

40

100

Tracks

Special interest, regional,
and user group meetings

275

Technical workshops

300

Exhibitors

600

User presentations, map
posters, and special displays

Register Now
The registration deadline is May 21, 2010. Some complimentary conference
registrations are often available with an organization’s ArcGIS software maintenance
plan. A customizable letter of justification for attending the conference can be
downloaded from www.esri.com/uc.
Special rate hotel rooms can also be booked online at www.esri.com/uc. Staying
in downtown San Diego at a participating conference hotel offers the best value and
convenience when it comes to travel, amenities, networking, and attending events at
the Convention Center. (Special rates are not guaranteed after June 10.)
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at the ESRI International User Conference

For one week, in one place, ESRI software users from around the globe will have everything
related to GIS technology at their fingertips.
The ESRI International User Conference is
open to all ESRI GIS users.
That week will be July 12–16, 2010, when
thousands of people interested in geospatial
technology will gather for the ESRI UC at the
San Diego Convention Center in California.
“Our users are inspired people doing important work with GIS,” says ESRI president
Jack Dangermond. “They continue to astound
us each year with the quantifiable, meaningful, and powerful differences they’re making
in the world. The User Conference should be
invaluable, a conference you can’t help but
get something out of, whether it’s help with
a project or recognition for the work you do.
It’s a forum where creativity and new ideas are
appreciated and shared.”
It’s also where ESRI software users will
learn about ArcGIS 10, due for release soon.
“This is a very big release,” says Dangermond,
adding that it will be “cloud ready.” ESRI has
a new relationship with Amazon Web Services
to host ArcGIS in its cloud.
ArcGIS 10 will be demonstrated at the Plenary Session on Monday, July 12, and will be
the focus of many other discussions, demos,
and workshops. Improvements will include
easier data creation and management, the integration of space and time for temporal spatial
support, 3D models and visualization tools,
mapmaking time-savers, enhanced editing and
sharing capabilities, and new ways to perform
analysis and modeling.

“ArcGIS 10 simplifies working with a GIS.
It puts the map up front,” Dangermond says.
Enhanced by cloud computing and Web services, “this is an easier, more accessible, and
collaborative GIS.”
Dangermond also will share his vision of
GIS during the plenary and talk about how
many different industries use the technology
to plan and make better decisions. Interesting and noteworthy guest speakers will give
keynote talks that highlight the importance of
geospatial information and technology.
A Full Schedule
The ESRI UC offers a broad slate of events
and activities that revolve around the latest
geospatial technology developments and applications such as specialized tracks; user
presentations; technical workshops; special
interest, regional, and user group meetings and
exhibits; map posters; and special displays.
The Map Gallery opening will follow the
plenary. Visitors will be able to browse through
the collection of maps that illustrate how GIS
is used by a wide variety of organizations in
more than 100 countries. Groups such as the
National Geographic Society and the Smithsonian also will present colorful map displays.
The Exhibit Pavilion will house a variety of
technology vendors. Attendees can watch GIS
demonstrations; speak to ESRI staff about
technical support; and see how geospatial
technology is used in business, public safety,
defense, utilities, and other sectors, in the
ESRI Showcase.
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Unique Highlights
Midweek, ESRI will honor the winners of the
Special Achievement in GIS (SAG) awards at
a ceremony. Organizations are lauded for their
extraordinary use of GIS. Winners demonstrate
vision and leadership in applying the technology to better serve society, such as enabling
faster 911 response and creating informationrich public Web sites.
GIS Kids Camp will provide school-age
children with a way to explore GIS. And the
popular Thursday Night Celebration always
boasts a new theme.
Another draw is the Spatial Outlet and
bookstore, which sells books about GIS including titles from ESRI Press. Authors also
will be on hand, signing books.
Play a Part
Attendees make the conference a success and
worthwhile for their peers. Here’s how to
participate:
 Give a Lightning Talk—a clear, quick, and
informal presentation that’s completed
in five minutes or less. The deadline to
submit the presentation is April 30.
 Have your videos, screen captures, and
images featured in the plenary. The
submission deadline is May 28.
 Share your paper and digital maps
that illustrate the power of GIS. The
submission deadline is June 14.
Submission details will soon be available at
www.esri.com/uc.
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The Geographic Approach for the Nation














Highlights from FedUC

“GIS is changing things; it is changing—actually—everything,” asserted ESRI president
Jack Dangermond in his address to the more
than 3,000 attendees of the ESRI Federal User
Conference (FedUC), held February 17–19,
2010 in Washington, D.C.
The first FedUC was held 15 years
ago. FedUC attendees represent a diverse
group that forms one community drawn from
civilian GIS users across many disciplines and
interests as well as users in the military and
intelligence communities.
The conference theme this year, The Geographic Approach for the Nation, underlined
the message that a national GIS is emerging.
This distributed network of systems and services supports national policies and priorities.
A geography-based approach enables transparency and accountability in government
processes, allows better performance mea-





surement and place-based approaches to governance; and encourages citizen engagement.
“The first step in open government is
showing where you’re putting money,”
Dangermond said. “The second way GIS can
help is overlaying maps of where there are
problems. That’s where you start to get into an
information-driven government.”
In a new era of open government, GIS is
enabling transparency and accountability by
making projects’ status and expenditures more
easily known. During the Plenary Session,
ESRI staff demonstrated GIS applications that
are making government more accessible and
decisions more information driven. Recovery.
com has been a tremendously popular site that
uses maps linked to charts that allow visitors
to drill into information to discover which
funds are being spent where. Another example
shown was the U.S. Department of Transpor-

Master of Science in GIS
at the University of Redlands

O

ur MS GIS Program is designed for an audience of professionals seeking to
improve their knowledge of the analysis and management of geographic

information. We offer both a full-time and a part-time residential program. Within the
University’s interdisciplinary learning environment, students have an unparalleled
opportunity to interact personally not only with University faculty, staff, and students
from other programs, but also with the many talented professionals at the world’s

leading GIS company, ESRI, located in close proximity to the University.
The University of Redlands, founded in 1907, is a fully-accredited, liberal arts and
sciences university. This intensive, international learning environment ensures a global
context of relevance to students from around the world. Graduates of this program
can become GIS practitioners prepared for positions such as project managers,
applications specialists, and applications software development team members.

For information call (909) 748-8128 or visit
www.msgis.redlands.edu















tation stimulus spending site which addresses
accountability by answering why money was
spent on particular projects. ESRI has developed Web templates that streamline the process
of building Web sites for tracking stimulus
spending and projects. These templates are being used by many federal and state agencies.
ChesapeakeStat was cited as an example of
how GIS is aiding performance management.
This site provides far greater access to program
information and interactive capabilities that
complement existing paper processes.
GIS is quite naturally supporting the development of place-based policies so government
can more easily target priority places, coordinate projects and programs, and support integrated decision making.
The enhanced mobile capabilities of GIS
are also leading to increased citizen engagement with government. Through the use of
Web and mobile technologies, volunteered
geographic information (VGI) is emerging.
VGI makes it possible for every citizen to be a
“sensor.” GIS could be used not only for gathering the observations of millions of people
but also integrating them. Now citizens can
help build a national GIS.
Another conference theme was Gov
2.0—an approach that views government as
a platform for getting things done by bringing the advantages of Web 2.0 to government.
GIS helps government make its data and information available to other organizations so
they can more effectively do their jobs. The
conference keynote speaker, Dr. John Holdren, noted that good decisions can’t be made
without good data. “That’s why the Obama
administration has placed such a priority on
putting high-quality data in the center of the
executive branch.” Not just good data but the
ability to visualize that data is crucial for decision makers in the government and the public. Data visualization is one of the strengths
of GIS. Holdren is President Obama’s science
and technology advisor and the director of the
White House Office of Science and Technology Policy.
As Dangermond noted during the Plenary
Session, GIS professionals are building authoritative data, high-quality maps, performing analysis, and developing models and applications that make information available in a
much more timely manner. He contrasted the
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months it took to integrate and analyze data
associated with the response to Hurricane Katrina in 2005 with the minutes it took to acquire
the same kind of common operational picture
(COP) for the Los Angeles fires in 2009.
Many presentations at FedUC provided
more information on the impending release of
ArcGIS 10. This release focuses on GIS development on the Web.With ArcGIS 10, GIS is
easier, accessible, and collaborative and uses
cloud architecture, Web services, information
integration, crowd sourcing, and open data















sharing.
ESRI also announced during the conference
that it is collaborating with Amazon Web Services (AWS) and has joined the growing community of AWS Independent Software Vendors
(ISVs) building services and solutions in the
cloud computing environment.
Developments in organizational cooperation coupled with increased GIS software
capabilities and pervasive data collection is
building a body of knowledge that is quite extraordinary and will further enable the use of

Transforming GIS
2009 ESRI Middle East and North Africa User Conference
More than 450 professionals from executives and managers to GIS and IT end users
gathered in Manama, Bahrain, for the 2009
ESRI Middle East and North Africa User
Conference (MEAUC).
This event for ESRI users in the Middle
East and North Africa was held November
10–12 at the Diplomat Radisson Blu Hotel.
MEAUC is a forum for learning about the
newest developments in GIS and building
relationships with other members of the international ESRI user community.
The conference was held under the patronage of His Excellency Sheikh Mohammed bin
Mubarak Al Khalifa, Deputy Prime Minister
for the Government of Bahrain. Khalifa
deputized His Excellency Sheikh Ahmed
Ateyatalla Al Khalifa, Minister of Cabinet
Affairs for the Kingdom of Bahrain, to attend
the conference in his stead.
“GIS is slowly transforming into a pervasive technology,” said Dr. Ghulum Bakiri
from MicroCenter, the ESRI distributor in
Bahrain. “And many countries in the region
are embarking on a national NSDI [National
Spatial Data Infrastructure] initiative to
act as the platform of choice for integrating
diverse islands of information that exist in
various departments and government organizations. This conference gave GIS professionals and decision makers an outstanding
opportunity to share their experiences and
gain valuable insight into essential best practices in this challenging undertaking.”
Attendees heard from ESRI president Jack
Dangermond during the Plenary Session. He
discussed his vision for GIS, its impact on the
world, and explained that now GIS is not only



about providing maps and information but is
also an indispensable tool for analysis and
decision making for developing environmental policies and urban plans.
At conference sessions, users had questions answered and learned how to obtain
results in their organizations and communities through using GIS. They saw the latest
GIS tools and applications, heard about
time-saving tips and tricks, and met with
ESRI staff and business partners. Technical
workshops, led by ESRI product managers
and paper sessions on successful GIS applications showed attendees new ways to get
solutions to technical issues and cost-saving
ideas for specific markets.
For the region’s next gathering, users in
the Middle East and North Africa are invited
to attend a combination European User
Conference (EUC) October 26–28, 2010,
in Rome, Italy. See the annoucement in the
accompanying article, “Upcoming Conferences” on this page.
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geography and GIS as an organizing principle
for governance and society.
In accepting the Making a Difference
award, Tim Trainor, chief of the Geography
Division of the United States Census Bureau,
noted, “We are at a very good time. It’s at a
convergence of lots of technology, lots of
very rich software, rich datasets, and a highly
skilled professional body that can actually use
that data. This is our time.”

Upcoming Conferences
2010 EMEA Conference
The 2010 ESRI Europe, Middle East,
and North Africa User Conference
(EMEA) will take place October 26–28
in Rome, Italy, at the Ergife Palace Hotel. The EMEA is being hosted by ESRI
Italia, the ESRI distributor in Italy. This
union of the European User Conference
(EUC) and Middle East and North Africa
User Conference (MEAUC) gives users
throughout these regions the chance to
connect with an even larger ESRI community. More information is available at
www.esri.com/meauc.
ESRI Latin America User Conference
The ESRI Latin America User Conference (LAUC), in its 17th year, will be
held September 22–24, 2010, in Mexico
City, Mexico. The event, hosted by the
ESRI distributor in Mexico, SIGSA, will
be held at the Sheraton Maria Isabel Hotel & Towers on the Paseo de la Reforma.
The LAUC is the premier event for GIS
users throughout Latin America and between 800 and 1,000 attendees are expected. Participants can form valuable relationships with peers and meet with key
contacts—from ESRI staff and business
partners to the region’s industry leaders.
Attendess can find out how to launch and
grow successful GIS projects and share
geographic knowledge. Learn more, register, and see how to participate at www.
sigsa.info/lauc2010.
For a complete listing of ESRI events
worldwide, visit www.esri.com/events.
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A Decade of Success
Combining geospatial technology and problem-solving skills
By Michael Winston, Shelly School District
A program developed by an Idaho school district encourages students
to use GIS skills to solve real-world problems. Teachers in the Shelley
School District have been using GIS technology for a decade. The Solutions program developed by the district exposes students to new technologies and skills that are valuable in the problem-solving process.
Shelley School District is located about 20 miles from the Idaho
National Laboratory (INL), a national science laboratory. The district’s
teachers were first introduced to GIS technology at INL, and GIS was a
natural fit for the Solutions program. Some of the GIS projects students
have worked on over the years include using current census data to
redistrict the school board zones, creating maps for the City of Shelley
showing fire hydrant locations, and mapping noxious weeds for county
and state weed agencies.
Teachers like to involve students in both short-term projects and longer-term projects. Short-term projects help students gain an initial sense
of accomplishment, which instills the confidence that will be required
for longer-term projects. Long-term projects generally require higher
skill levels but can be rewarding for students who persevere.
As successful as these GIS projects have been, teachers were concerned that too many students were passing up opportunities to work
with GIS projects, and many students involved in GIS projects were
learning advanced computer skills but lacked basic map-reading skills.
As a result, the program was restructured. Students are now introduced
to mapmaking/map-reading skills at a younger age. For example, students learn how to make simple compasses, how to make maps, how to
read topographic maps, and how to use GPS technology in geocaching
activities. This introduction exposes more students to GIS and helps
them pick up basic skills.
One project, Holding the Line, is a
capstone effort that exemplifies the aspirations teachers have for effectively
incorporating GIS in the classroom. This
project addressed the slow spread of noxious weeds toward Yellowstone National
Park. Current weed control measures had
not been effective in preventing the spread
of one weed in particular: leafy spurge

(Euphorbia esula). A consortium of government agencies, weed control entities, watershed organizations, and interested citizens banded
together to stop the spread of leafy spurge to Yellowstone Park.
Rebecca Schneiderhan, who has since graduated and has her own
GIS consulting business, was contracted to oversee the distribution of
four million beetles as part of a biological control effort started more
than 10 years ago. The beetles are effective in controlling leafy spurge
but harmless to native flora and fauna. They are released at marked sites
that have been studied for years to determine how effective the beetles
are in controlling spurge. Schneiderhan was tasked with collecting two
million beetles from previous release sites, purchasing two million additional beetles, then releasing all four million beetles in areas adjacent
to the Yellowstone Park boundaries. The beetles were successfully collected, and released at target sites, and those sites were mapped.
Much of the beetle collecting and mapping was done using the services of Paul Muirbrook, an individual who established a business that
hires high school students and high school graduates to perform various
GIS/GPS tasks for local government agencies. Schneiderhan was also
assisted by a second grade student who helped collect beetles and map
the sites. These sites will be monitored for the next five years to determine the effectiveness of the effort in preventing the spread of leafy
spurge.
This project is considered a capstone project for Shelley District’s
GIS efforts because it provides opportunities to help solve real-world
problems and helps students of all ages develop multiple skills. For
example, students involved in this project learned about plants (weeds),
insects, Yellowstone Park, government agency interactions, and how
GPS and GIS technologies can be used. It also provided employment
opportunities for both entrepreneurs and summer hires and helped build
partnerships between government agencies and schools.
In summary, Shelley School District’s efforts to expose students to
GIS/GPS technologies have evolved over the years. The district’s teachers now attempt to introduce students to mapmaking fundamentals at an
early age and seek projects that involve solving real-world problems, encouraging students to use their skills in the solutions of those problems.
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New ESRI Authorized Instructors
The Authorized Training Program (ATP) is pleased to acknowledge the newest class of ESRI Authorized
Instructors. These candidates have passed all ATP requirements and have been granted authorization
to teach the specified ESRI courses within the United States and United States Territories, excluding
Puerto Rico. These instructors join a network of over 250 Authorized Instructors. To locate an Authorized
Instructor in your area, visit www.esri.com/atp, contact ATP by e-mail at atp@esri.com, or call
909-793-2853, extension 1-2111.
Abbreviations for each course authorization are listed in the accompanying table. The course
authorizations shown with each instructor listed indicate only the most recent authorization(s) received by
that instructor. Visit the ATP Web site for complete information on all authorizations held by an instructor.
California
Tobias Wolf
HDR Engineering, Inc.
San Diego, CA
858-712-8370
tobias.wolf@hdrinc.com
AGD2

Jill Schmid
Rookery Bay National Estuarine
Research Reserve
Naples, FL
239-417-6310
jill.schmid@dep.state.fl.us
AGD3

Oregon
Craig Greenwald
GeoMobile Innovations, Inc.
Corvallis, OR
541-754-3488
craig@geomobileinnovations.com
AGD1

District of Columbia
Eva Stern
District of Columbia
Office of the Chief Technology Officer
Washington, DC
202-727-4946
eva.stern@dc.gov
AGD2

Mississippi
Nel Ruffin
Mississippi State University
Geosciences Dept.
Mississippi State, MS
662-325-7459
nr19@msstate.edu
BGDB

South Carolina
Carmen Durham
City of Greenville
Greenville, SC
864-467-4512
cdurham@greenvillesc.gov
AGD2

Florida
Laura Castelnovo
City of Lakeland
Lakeland, FL
863-834-8340
laura.castelnovo@lakelandgov.net
AGD1, AGD2

New York
Gregory Coniglio
Ecology and Environment, Inc.
Lancaster, NY
716-684-8060
gconiglio@ene.com
AGD3

Tracy McKee
City of Charleston
Charleston, SC
843-724-3769
mckeet@ci.charleston.sc.us
AGD2

Course Abbreviations
AG1
AG2
AGD1
AGD2
AGD3
AGSA
BGDB
IAGS
LGAD
MGDB
PAO
PAOJ
PAON
PYTH

Introduction to ArcGIS I (for ArcGIS 9)
Introduction to ArcGIS II (for ArcGIS 9)
ArcGIS Desktop I
ArcGIS Desktop II
ArcGIS Desktop III
Working with ArcGIS Spatial Analyst
Building Geodatabases
Introduction to ArcGIS Server
Learning GIS Using ArcGIS Desktop
Introduction to the Multiuser Geodatabase
Introduction to Programming ArcObjects with VBA
Introduction to Programming ArcObjects Using the
Java Platform
Introduction to Programming ArcObjects Using the
Microsoft .NET Framework
Introduction to Geoprocessing Scripts Using Python

Texas
Eric Sheehan
Denbury Resources, Inc.
Plano, TX
972-673-2103
eric.sheehan@denbury.com
AGD1

Wisconsin
Todd Niedermeyer
Geographic Marketing Advantage
Franklin, WI
414-525-1600
tniedermeyer@geoadvantage.com
AGD2

Virginia
Sandra Belson
Intelliware Systems, Inc.
Fredericksburg, VA
202-324-2059
sbelson@intelliwaresystems.com
AGD1, AGD2, AGD3, BGDB

PE n n Stat E | On l i n E
Geospatial Education Portfolio
Penn State offers high-quality online education programs
to help you achieve your personal and professional goals.
Master of Geographic Information Systems
Postbaccalaureate Certificate in Geographic
Information Systems
Postbaccalaureate Certificate in
Geospatial Intelligence

w w w.worldc ampu s .p su .e du/ar cu ser 09
U.Ed.OUT 10-0151/10-WC-090edc/bjm
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Many

Mobile GIS

Training Resources
ESRI courses for staff implementing these solutions
BlackBerrys, iPhones, smartphones, and other
mobile devices provide instant access to information—no matter where we are. Mobile GIS
is one of the technologies enabling this trend.
Many organizations, including utilities, public
works, and public safety agencies, use mobile
GIS to collect field data, ensure the currentness
of their GIS database, and maintain situational
awareness. ESRI provides training options for
staff who are responsible for implementing
and maintaining the mobile GIS solutions.
The Authoring and Serving ArcGIS Mobile
Projects instructor-led course teaches a recommended workflow for creating and deploying
an out-of-the-box ArcGIS Mobile project. The
course emphasizes the unique requirements of
a mobile project and uses a realistic mobile
GIS scenario to present concepts and the decision-making process needed to successfully
implement a mobile GIS project. Course exercises immerse students in the project planning
phase and each step in the mobile workflow all
the way through to project deployment.
Throughout the course, students learn how
to adapt existing data, maps, and GIS workflows to the mobile environment. Students create a geodatabase and choose a data transaction
model for a mobile project, design a mobile
map, and create optimized mobile map services for use in the field. Security considerations
and techniques for maintaining a mobile project over time are covered. Group discussions
and activities provide students with ample opportunity to strategize and share ideas for using the course project as a road map for other
mobile GIS projects.
The course is designed for GIS analysts
and experienced ArcGIS users who want to
deploy mobile GIS projects using out-of-thebox ArcGIS Mobile functionality. Developers
who want to understand core ArcGIS Mobile
functionality will also benefit from attending.
Building Applications Using the ArcGIS
Mobile SDK—This is another instructor-led
course that introduces the ArcGIS Mobile
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SDK (software development kit) for the Microsoft .NET Framework and teaches how to
design and build custom mobile applications
that enable situational awareness and realtime geographic data collection in the field.
Students will learn recommended practices for
integrating mobile controls and multiple data
sources in mobile applications deployed in the
Windows 32 (Tablet PC) and Windows Mobile
(smartphone and Pocket PC) environments.
In addition to the instructor-led courses,
ESRI has created a series of free Web training
seminars. These one-hour training seminars
provide information on how other organizations are using mobile GIS and what ESRI
mobile GIS solutions are available.
Creating a Common Operational Picture
with ArcGIS—Agencies responding to emergencies such as wildfires, chemical spills, or
homeland security threats rely on a common
operational picture (COP) to monitor, respond
to, and manage the situation. By combining
GIS basemap data with changing, real-time
event data from cameras, a COP creates broad
situational awareness by sensors and other
means of communication. This seminar examines how a COP system can be created using
ESRI’s ArcGIS Server technology.
Introduction to ArcLogistics Navigator—
ArcLogistics Navigator, a new product
within the ArcLogistics solution, extends
the efficiencies gained with optimization in
ArcLogistics to the vehicle with turn-by-turn
guidance. This seminar covers ArcLogistics
and ArcLogistics Service Pack 1, setting up
navigation and sending and receiving routes
from ArcLogistics to a mobile device.
Introduction to ESRI Mobile GIS Solutions—Mobile GIS is currently used by government, utility companies, public safety
agencies, and commercial organizations to
streamline business processes and collect upto-date information about assets, infrastructure, and conditions in the field. This seminar
helps organizations evaluate ESRI mobile

www.esri.com

Education

GIS solutions. It will assist organizations in
identifying their mobile technology needs and
determine the mobile GIS solution that best
meets those needs. The presenter examines
each solution’s unique purpose, use cases, and
deployment options.
Maximizing GPS Accuracy in GIS Data
Collection—The application of GPS in civilian

markets has evolved from high-value surveying and timing industries, where accurate location was critical, to more recent widespread
adoption in location-aware applications on
consumer handsets. GPS plays a critical role
in enterprise field service and work automation systems where mobile GIS tools leverage
GPS to help workers locate themselves, navi-

More Training

Courses
ESRI constantly develops new courses that
teach the skills and knowledge you need to
succeed in the rapidly changing field of geospatial technology. You can upgrade your
skills, investigate a new career path, or stay
current with the industry. Learn how to make
the best use of data sources, perform analyses,
disseminate information effectively, and develop applications.
Instructor-led courses are offered in several formats: instructor-led courses taught in
a traditional classroom setting; instructor-led,
virtual classroom courses that include lectures
and hands-on exercises in an interactive, online classroom; and instructor-led courses
taught by ESRI Professional Services, which
cover specific industry solutions or products.
Self-paced, multiple module Virtual Campus Web courses are available as well as Virtual Campus free, one-hour training seminars.
Instructional podcasts are free, short audio recordings.
Desktop GIS
Using Lidar Data in ArcGIS—This Web
course is designed for data managers and GIS
analysts and teaches how to transform large
lidar datasets and prepare them for threedimensional visualization, modeling, and
analysis in the ArcGIS Desktop environment.
Learn how to derive terrains, digital elevation
models (DEMs), and intensity imagery from
lidar data, then use this data for advanced 3D
modeling and analysis.

www.esri.com

gate to their work, and accurately collect new
geographic information. This presentation examines techniques for maximizing accuracy of
GPS in mobile GIS data collection.
For more information and to register for
these and other courses, visit www.esri.com/
training.

Web
Classroom
Creating and Publishing Maps with
ArcGIS—This instructor-led course teaches
how to employ the elements of good cartography as part of a standard process that you can
apply each time you make a map. You learn
to create maps that are easy to interpret and
properly designed for their audience and delivery medium.
Performing Analysis with ArcGIS
Desktop—Learn strategies for planning an
analysis project and techniques for solving a
variety of spatial problems in this instructorled course. This course teaches a proven process that can be applied to all types of spatial
analysis projects.
Working with CAD Data in ArcGIS
Desktop—This course teaches fundamental concepts of CAD data integration within
ArcGIS. This instructor-led, virtual classroom

Podcasts
course provides best practices for working
with native CAD data in ArcGIS, converting
CAD data to GIS data, and options for converting GIS data to CAD formats.
Server GIS
Building Web Maps Using the ArcGIS API
for JavaScript—Learn how to create highperforming Web maps that share GIS content
on the Web in this instructor-led course. This
course teaches how to create Web maps that
are attractive, fast, and easily used by their
intended audience. Learn how to build lightweight, focused Web maps that utilize internal
and external ArcGIS Server Web services.
Extending ArcGIS Explorer for
Developers—In one hour, learn how you
can rapidly develop a user-friendly front end
for GIS data or ArcGIS Server services in this
free Web training seminar.

For More Information
ESRI Training Web Site

www.esri.com/training

ESRI Training Matters Blog

www.esri.com/trainingblog

Instructional Series Podcasts

www.esri.com/podinstruct

Follow ESRI Training on Twitter

www.twitter.com/ESRItraining

ESRI Press Books

www.esri.com/esripress

Subscribe to the ESRI Course Catalog

www.esri.com/coursecat

Subscribe to the ESRI Press Catalog

www.esri.com/epcatalog

Subscribe to ESRI Training News

www.esri.com/edtrainingnews
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By Michael N. DeMers, New Mexico State University

The author, shown as his avatar Gadget Loon, and his GIS class students hosted a GIS Day event in Second Life.

Goes Virtual

A less expensive, transportable, and interactive event in the metaverse
By Michael N. DeMers, New Mexico State University
At New Mexico State University (NMSU), the 2009 GIS Day celebration took on quite a different look from previous years. Attendees
donned avatar shapes and digital costumes to view student posters and
projects inside a virtual display area in a portion of a multiuser virtual
environment called Second Life.
Aggie Island, as this virtual environment is known, is owned and
maintained by the university’s College of Extended Learning and Information and Communications Technologies. As part of the author’s
Geography 481 class, which teaches the fundamentals of GIS,
15 students voluntarily created virtual posters that demonstrated their
GIS accomplishments. These students received official ESRI Certifi-

cates of Participation that are displayed on the backs of their posters.
The display opened on GIS Day (November 18, 2009) and has been
kept up to encourage GIS education and the use of virtual worlds, such
as Second Life, for learning, exposition, and collaboration.
The event, staged in the center of Aggie Island, resembled a scaleddown, virtual version of a poster session at the ESRI International
User Conference. As with real-world poster sessions, there was food
(all digital and calorie free), beverages (including virtual champagne),
free goodies (such as virtual GIS Day ball caps and T-shirts), and lots
of information about GIS and how it is used. A small movie theater
showed a YouTube video that introduced GIS to visitors who were
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End Notes

As part of the virtual GIS Day, students created virtual posters that
demonstrated their GIS accomplishments.
new to the topic. Student volunteer avatars provided attendees with
directions and encouragement. These avatar students also staffed an
information desk that provided materials about the GIS courses available from NMSU as well as information about the National Geography
Awareness Week event that was taking place on campus concurrently
with the GIS Day events in Second Life.
Since it opened, the virtual GIS Day display on Aggie Island has
received nearly 100 avatar visitors from different parts of the United
States and abroad—many more attendees than could be expected
from a one-day, real-world event held in a small venue. However, the
advantages of having such an event in a virtual world go beyond just
the number of attendees.
First, a virtual event minimizes cost. Printing an average poster
costs between $30 and $100. If the current poster display was created in the real world, it would cost at least $450 and possibly as
much as $1,500. Posters and certificates for the event cost the author
a grand total of $300—in Linden dollars, the currency of Second
Life. At the current U.S.-Linden dollar exchange rate, the cost was
approximately $1.25.
Second, setting up a real poster display typically involves renting
display boards and space, physically moving the displays and tables
around, and setting up the posters themselves. Besides the hours
involved, the cost is sometimes prohibitive if there are many attendees.
Perhaps the most important advantage of a virtual GIS Day event
is that the entire display—including the structures—is portable. It can
all be moved to a different location, such as a traveling display. The
Aggie Island display will be part of an ESRI-sponsored event at the
March Microcomputers in Education Conference in Tempe, Arizona.
This is similar to the high school lyceums that were popular years ago,
but without the expense. This would be an effective and inexpensive
way to get the word out to more potential GIS users. In fact, Linden
Laboratories, the owners of Second Life, also have a Teen Grid that allows secondary teachers to have GIS poster sessions for their classes.
The possibilities, to steal words from ESRI president Jack
www.esri.com

Like real-world poster sessions, the virtual version had food,
beverages, and swag. The food and drink were digital and calorie
free, and the free goodies included virtual ball caps and T-shirts.

Dangermond, “. . . are limited only by your imagination.”
For the immediate future, the NMSU GIS Day poster display can
be accessed in Second Life using the following landmark: AggieLand
Public, NMSU Aggie Island (133, 76, 26). For more information, contact the author’s avatar, Gadget Loon, in Second Life through instant
messaging or directly (in the nonvirtual world) at
Michael N. DeMers
Department of Geography
New Mexico State University
Las Cruces, New Mexico 88003
E-mail: demers01@gmail.com
Tel.: 575-496-5231
About the Author
DeMers is the author of another article on this topic, “Inside the
Metaverse: A ‘Second Life’ for GIS Education,” which appears in the
Winter 2009 issue of ArcUser.
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Trimble Yuma tablet, visit:
trimble.com/yuma_for_mgis.
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